
Ahsay Offsite Backup Server v5.2 
 
Administrator’s Guide 
 

Version 5.2.5.0 
Jan 2008 



Ahsay Offsite Backup Server v5.2 
 
Administrator’s Guide 

 
Copyright Notice 

 
© Ahsay Systems Corporation Limited 2008. All rights reserved. 
 
Author: Scherring Chong 
 
The use and copying of this product is subject to a license agreement. Any other use is prohibited. No part of this publication 
may be reproduced, transmitted, transcribed, stored in a retrieval system or translated into any language in any form by any 
means without the prior written consent of Ahsay Systems Corporation Limited. Information in this manual is subject to 
change without notice and does not represent a commitment on the part of the vendor. Ahsay Systems Corporation Limited 
does not warrant that this document is error free. If you find any errors in this document, please report Ahsay Systems 
Corporation Limited in writing. 
 
This product includes software developed by the Apache Software Foundation (http://www.apache.org/). 

 
Trademarks 

 
Microsoft, Windows, Microsoft Exchange Server and Microsoft SQL Server are registered trademarks of Microsoft Corporation. 
Sun, Solaris, SPARC, Java and Java Runtime Environment are registered trademarks of Sun Microsystems Inc. 
Oracle, Oracle 8i, Oracle 9i are registered trademarks of Oracle Corporation. 
Lotus, Domino, Notes are registered trademark of IBM Corporation. 
Red Hat is registered trademark of Red Hat, Inc. 
Linux is registered trademark of Linus Torvalds. 
Apple and Mac OS X are registered trademarks of Apple Computer, Inc. 
 
All other product names are registered trademarks of their respective owners. 

http://www.apache.org/


We back up your business 
Ahsay Offsite Backup Server v5.2

Administrator’s Guide

Ahsay Systems Corporation Limited Page 3 of 85 (April 15, 2008)

Table of Content 
 

1 Overview .......................................................................................................................................6 
1.1 Benefits........................................................................................................................................................................6 
1.2 Features .......................................................................................................................................................................6 
1.3 Security........................................................................................................................................................................7 
1.4 System Requirements ..................................................................................................................................................7 

2 Installation .....................................................................................................................................9 
2.1 Install Software............................................................................................................................................................9 
2.2 Startup/Shutdown ........................................................................................................................................................9 
2.3 Uninstall Software .....................................................................................................................................................10 

3 Quick Start...................................................................................................................................11 
3.1 Getting started ...........................................................................................................................................................11 

4 Best Practices and Recommendations.........................................................................................15 
4.1 Setting [System Home] and [User Homes] to disk partition with large free space ....................................................15 
4.2 Disk partitions larger than 500GB.............................................................................................................................15 
4.3 Running OBS as non-root user..................................................................................................................................15 
4.4 Expose only TCP port 80 and 443 to the public........................................................................................................15 

5 Server Configuration ...................................................................................................................16 
5.1 User Languages Setting .............................................................................................................................................17 
5.2 System Login Name/Password ..................................................................................................................................19 
5.3 Host Name.................................................................................................................................................................19 
5.4 System Home and User Home Directories ................................................................................................................19 
5.5 Email System Setting.................................................................................................................................................20 
5.6 Proxy Setting .............................................................................................................................................................20 
5.7 Features Setting .........................................................................................................................................................20 
5.8 File Permissions.........................................................................................................................................................21 
5.9 Free Trial Setting.......................................................................................................................................................21 

6 Software License .........................................................................................................................22 
6.1 Licensee Name and License Key ...............................................................................................................................23 
6.2 Automatic License Renewal ......................................................................................................................................23 

7 Managing Routine Job ................................................................................................................24 
7.1 Backup Report ...........................................................................................................................................................25 
7.2 Online Restore Report ...............................................................................................................................................25 
7.3 Setting Change Report...............................................................................................................................................25 
7.4 Missed Backup Report...............................................................................................................................................25 
7.5 Inactive User Report ..................................................................................................................................................25 
7.6 Off-line Backup Reminder.........................................................................................................................................25 
7.7 Backup Quota Reminder............................................................................................................................................26 
7.8 Trial User Reminder ..................................................................................................................................................26 
7.9 Usage Report .............................................................................................................................................................26 
7.10 Error Report...............................................................................................................................................................26 
7.11 Inactive User Removal...............................................................................................................................................26 
7.12 Retention Policy ........................................................................................................................................................26 
7.13 Rebuild User Storage.................................................................................................................................................27 
7.14 System Log Removal.................................................................................................................................................27 
7.15 Debug Log Removal..................................................................................................................................................27 

8 Managing Replication .................................................................................................................28 
9 Managing ACB Configuration ....................................................................................................29 

9.1 In-file Delta Settings for all ACB users .....................................................................................................................29 
9.2 Block Size..................................................................................................................................................................30 
9.3 Minimum Size ...........................................................................................................................................................30 
9.4 In-file Delta Type ......................................................................................................................................................30 
9.5 Upload Full File.........................................................................................................................................................30 
9.6 Advertisements ..........................................................................................................................................................31 

10 Managing User ............................................................................................................................33 
10.1 Create Backup User ...................................................................................................................................................33 
10.2 List / Remove Backup User .......................................................................................................................................34 



We back up your business 
Ahsay Offsite Backup Server v5.2

Administrator’s Guide

Ahsay Systems Corporation Limited Page 4 of 85 (April 15, 2008)

10.3 Broadcast messages to backup users..........................................................................................................................35 
10.4 Managing User Profile...............................................................................................................................................35 
10.5 Managing Backup Set................................................................................................................................................37 
10.6 Browsing User Backup File.......................................................................................................................................38 
10.7 Reviewing User Backup Report.................................................................................................................................38 
10.8 Reviewing User Storage Statistic...............................................................................................................................39 

11 AutoUpdate .................................................................................................................................40 
11.1 How it works .............................................................................................................................................................40 
11.2 Using AutoUpdate .....................................................................................................................................................40 
11.3 Customizing AutoUpdate ..........................................................................................................................................40 
11.4 Forcing an extra AutoUpdate.....................................................................................................................................41 

12 Backup / Restore files using off-line media ................................................................................42 
12.1 Seed loading backup files (Import)............................................................................................................................42 
12.2 Saving backup files to off-line media (Export)..........................................................................................................43 

13 Secure Socket Layer (SSL) Configuration ..................................................................................44 
13.1 Installing a trusted SSL certificate.............................................................................................................................44 
13.2 Enforcing SSL to the web interface ...........................................................................................................................46 

14 Monitoring System Activities .....................................................................................................47 
14.1 Reviewing System Log..............................................................................................................................................47 
14.2 Reviewing Backup Log .............................................................................................................................................47 
14.3 Reviewing Restored File Log ....................................................................................................................................48 
14.4 Reviewing Backup Error Log ....................................................................................................................................49 
14.5 Reviewing Advertisement Log ..................................................................................................................................49 
14.6 Reviewing access logs ...............................................................................................................................................50 

15 Branding OBM (Partners Only) ..................................................................................................51 
15.1 Customization Portal .................................................................................................................................................51 

16 Branding OBS .............................................................................................................................52 
16.1 Welcome page ...........................................................................................................................................................52 
16.2 Different welcome pages for different domains.........................................................................................................52 
16.3 Customizing the company logo displayed .................................................................................................................52 
16.4 Customizing the Look and Feel of the web interface.................................................................................................53 
16.5 Customizing all text of the web interface ..................................................................................................................54 
16.6 Customizing email reports .........................................................................................................................................54 
16.7 Localizing the software..............................................................................................................................................55 

17 Other Configuration ....................................................................................................................56 
17.1 Listening to non-standard TCP/IP Port .....................................................................................................................56 
17.2 Listening to a single IP address .................................................................................................................................57 
17.3 Backing up OBS........................................................................................................................................................58 
17.4 Restricting access to system page by IP address........................................................................................................58 

18 External APIs ..............................................................................................................................59 
18.1 Overview ...................................................................................................................................................................59 
18.2 IP Restrictions ...........................................................................................................................................................59 
18.3 User Authorization ....................................................................................................................................................60 
18.4 Adding User...............................................................................................................................................................60 
18.5 Modifying User Profile..............................................................................................................................................61 
18.6 Deleting User.............................................................................................................................................................63 
18.7 Listing Users..............................................................................................................................................................63 
18.8 Getting User Information...........................................................................................................................................64 
18.9 Adding a Backup Set .................................................................................................................................................65 
18.10 Deleting a Backup Set ...............................................................................................................................................65 
18.11 Listing Backup Sets ...................................................................................................................................................65 
18.12 Getting a Backup Set .................................................................................................................................................66 
18.13 Updating a Backup Set ..............................................................................................................................................69 
18.14 Listing Backup Jobs...................................................................................................................................................69 
18.15 Listing Backup Job Status .........................................................................................................................................69 
18.16 Getting Backup Job Report........................................................................................................................................70 
18.17 Getting Backup Job Report Summary .......................................................................................................................71 
18.18 Listing Backup Files..................................................................................................................................................72 
18.19 Getting User Storage Statistics ..................................................................................................................................72 
18.20 Listing User Storage ..................................................................................................................................................73 
18.21 Get License ................................................................................................................................................................74 



We back up your business 
Ahsay Offsite Backup Server v5.2

Administrator’s Guide

Ahsay Systems Corporation Limited Page 5 of 85 (April 15, 2008)

18.22 Get Replication Mode................................................................................................................................................75 
18.23 Send Forgot Password Email.....................................................................................................................................75 
18.24 Additional APIs .........................................................................................................................................................75 

19 Frequently Asked Questions........................................................................................................76 
19.1 How to backup OBS? ................................................................................................................................................76 
19.2 How can I rebuild an OBS server from scratch?........................................................................................................76 
19.3 How can I relocate users between different user homes?...........................................................................................77 
19.4 How do I add new storage to an existing server?.......................................................................................................77 
19.5 How can I tell which OBM version is being used to run a backup job?....................................................................77 
19.6 How to run OBS under non-root user under Linux/Unix? ........................................................................................78 
19.7 How do I start up RPS as OBS? ................................................................................................................................80 
19.8 How do I move OBS to a new IP address? ................................................................................................................81 
19.9 How do I move OBS to a new server?.......................................................................................................................81 
19.10 How do I set the user home directory to a network drive?.........................................................................................82 
19.11 Can I perform an integrity check on all backup files stored under OBS? ..................................................................82 

20 Troubleshooting ..........................................................................................................................83 
20.1 I am getting the message “Error getting report from all IP addresses” in my email. What can I do to correct this?..83 
20.2 Some of my backup accounts have disappeared. What can I do to recover them? ....................................................83 
20.3 OBS running on Linux crashes unexpectedly and randomly when Samba is being used to access user home 

stored on another server?...........................................................................................................................................84 
21 Appendixes..................................................................................................................................85 

21.1 Contact Us .................................................................................................................................................................85 



We back up your business 
Ahsay Offsite Backup Server v5.2

Administrator’s Guide

Ahsay Systems Corporation Limited Page 6 of 85 (April 15, 2008)

1 Overview 

1.1 Benefits 
� Easy Backup of 

1. Microsoft Exchange Server 2000 / 2003 / 2007 
2. Microsoft SQL Server 7.0 / 2000 / 2005 
3. Lotus Domino/Notes 5.0 or above 
4. Oracle 8i or above 
5. MySQL 3.2.4 or above 
6. Windows System State 
7. Outlook and Outlook Express (i.e. *.pst, *.dbx and *.wab) 
8. Important personal settings, e.g. Desktop, Favorite, My Documents and History etc 
9. Other common files (e.g. *.doc, *.xls) 

� Support backing up only changes within a file (using in-file delta technology) 
� Support backing up of open files on Windows XP / 2003 / Vista (Volume Shadow Copy) 
� Support backing up of Windows NTFS access privileges, Linux access privileges and modes, Mac OS 

X metadata and resource forks 
� Easy to use, deploy and maintain 

1.2 Features 
� (New in 5.2) Full support of Microsoft Exchange individual email, contacts, calendars, tasks etc. 
� (New in 5.2) New easy to use backup client for home/SOHO users. 
� (New in 5.2) Allow the administrator to set whether to “copy a file” to retention area when the file 

permissions are updated. 
� (New in 5.2) Choose whether to restore “file permissions” during restore. 
� (New in 5.2) For “Local Copy” backup, ability to choose whether to perform a local copy backup only 

and skip the offsite backup. 
� (New in 5.2) Lotus Notes/Domino agent for Linux. 
� (New in 5.2) Auto Upgrade Agent to automatically upgrade the client software. 
� (OEM version only) All references to Ahsay can be removed or branded to your own company name, 

address, phone and email 
� (OEM version only) Allow unlimited backup trial accounts to be created on the backup server (with 

unlimited backup quota for a trial period of 30 days) 
� (OEM version only) Create branded installer for backup client software. No special setup is required to 

offer free trial subscriptions to potential users 
� User configurable incremental / differential in-file delta backup mode (i.e. backing up only changes 

within a file since the last incremental or full backup according to each user’s preference). 
� Allow in-file delta backup mode to be overridden by each user individually according to backup time 

(e.g. enforcing full (or incremental or differential) backup of all files on every Sunday or the 1st day of 
every month). 

� Volume Shadow Copy backup (i.e. backing up files even when they are exclusively open, e.g. 
Outlook.pst). 

� Bandwidth Throttling at backup account level. 
� In-File Delta backup (i.e. backing up only changes within files). 
� Off-line backup mode and logout backup reminder. 
� Real time backup server replication allows the backup server to be easily backed up. 
� Customizable backup schedule allows backup to be scheduled at any time. 
� Compress and encrypt data automatically before sending them to the server (server stores only 

encrypted data). 
� Increment backup strategy ensures that only new or updated files are sent to the backup server. 
� Support both full backup (database backup) and incremental backup (transaction log backup) for 

Microsoft SQL Server 7.0/2000, Microsoft Exchange Server 2000/2003, Lotus Domino/Notes 5.0 and 
Oracle 8i or above. 

� Can integrate with external “Open File Manager” to provide open file backup support to all open files. 
� Access backup data anytime, anywhere by using a web browser. 
� Comprehensive backup report lists all files backed up. Backup report will be delivered to user 

automatically via email. 
� Backup data are CRC validated before they are stored on server. 
� Fully user customizable data retention policy allows users to have access to deleted files using the 

least possible storage space on the backup server. 
� Select files to be backed up easily by using a backup filter, e.g. selecting all *.doc and *.xls in your 

computer in a single operation. 



We back up your business 
Ahsay Offsite Backup Server v5.2

Administrator’s Guide

Ahsay Systems Corporation Limited Page 7 of 85 (April 15, 2008)

� Run any custom OS commands before/after a backup job. 
� Run on Windows, Mac OS X, Linux, NetWare, Unix and all other platforms supporting a Java2 

Runtime Environment. 
� System activity report, showing all backup system information, will be delivered to system 

administrator via email everyday. 
� Complete set of external APIs allow system integration with external systems (e.g. billing/payment 

system) to be done easily. 
� Periodic backup files validation on backup server ensures backup files are 100% valid and fully 

restorable when needed. 

1.3 Security 
� 128-bit point-to-point SSL communication between server and client 
� Support HTTP/HTTPS Proxy and Socks v4/v5 firewall  
� Data are 128-bit encrypted when stored on backup server 
� Choice of different encryption algorithms, e.g. Twofish, Triple DES, Advanced Encryption Standard 

(AES) 
� Choice of different encryption modes, e.g. Electronic Cook Book (ECB) and Cipher Block Chaining 

(CBC) 
� An random initializing vector, salt and iteration count will be generated by the software automatically 

for each file when encrypting your data 
� Each backup user can restrict online access to his files to his pre-defined list of IP addresses 

1.4 System Requirements 
 

Server-side applications  

Supported Platforms  Hardware Requirements 

OBS • Windows 2000 / XP / 2003 (server 
recommended)  

• Linux kernel 2.4 or above  
• Solaris 2.x or above  
• AIX  
• HP-UX  
• FreeBSD  
• Mac OS X 10.2 or above  
• All other operating systems that 

supports Java2 Runtime Environment 
1.4.2 or above  

• Memory:  
o 512MB (minimum)  
o 1GB (recommended)  

• Disk Space:  
o 300MB  

• Network Protocol:  
o TCP/IP (http/https) 

RPS • Windows 2000 / XP / 2003 (server 
recommended)  

• Linux kernel 2.4 or above  
• Solaris 2.x or above  
• AIX  
• HP-UX  
• FreeBSD  
• Mac OS X 10.2 or above  
• All other operating systems that 

supports Java2 Runtime Environment 
1.4.2 or above  

• Memory:  
o 128MB (minimum)  
o 512MB (recommended)  

• Disk Space:  
o 100MB  

• Network Protocol:  
o TCP/IP (http/https) 

* The use of Windows 2000 WorkStation and XP Professional is only recommended for backup system with less 
than 20 users. For 20 or more users, please use Windows 2000 or 2003 Server instead. 

 



We back up your business 
Ahsay Offsite Backup Server v5.2

Administrator’s Guide

Ahsay Systems Corporation Limited Page 8 of 85 (April 15, 2008)

Client-side applications  

Supported Platforms  Application Compatibilities  Hardware Requirements 

OBM • Windows 95 / 98 / 
ME / NT / 2000 / XP 
/ 2003 / Vista  

• Linux kernel 2.4 or 
above  

• NetWare 5.1 or 
above  

• Solaris 2.x or above 
• AIX  
• HP-UX  
• FreeBSD  
• Mac OS X 10.2 or 

above  
• All other operating 

systems that 
supports Java2 
Runtime 
Environment 1.3.1 
or above  

• Microsoft Exchange 
Server 2000 / 2003 / 
2007  

• Microsoft SQL 
Server 7.0 / 2000 / 
2005  

• Lotus Domino / 
Lotus Notes 5.0 or 
above  

• Oracle 8i or above  
• MySQL 3.2.4 or 

above  
• Outlook / Outlook 

Express i.e. *.pst, 
*.dbx and *.wab  

• Other common files 
e.g. *.doc, *.xls  

• Also supports 
backing up of:  
o Windows System 

State (all 
platforms except 
Vista)  

o Windows NTFS 
access privileges 

o Linux access 
privileges and 
modes  

o Mac OS X 
metadata and 
resource forks  

• Memory:  
o 128MB 

(minimum)  
o 256MB 

(recommended) 
• Disk Space:  

o 110MB  
• Network Protocol: 

o TCP/IP 
(http/https) 

ACB • Windows 95 / 98 / 
ME / NT / 2000 / XP 
/ 2003 / Vista  

• Mac OS X 10.2 or 
above  

• Outlook / Outlook 
Express i.e. *.pst, 
*.dbx and *.wab  

• Other common files 
e.g. *.doc, *.xls  

• Also supports 
backing up of:  
o Windows NTFS 

access privileges 

• Memory:  
o 128MB 

(minimum)  
o 256MB 

(recommended) 
• Disk Space:  

o 110MB  
• Network Protocol: 

o TCP/IP 
(http/https) 
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2 Installation 
This chapter describes how to install/uninstall OBS onto/from your computer and how to startup/shutdown the 
OBS software installed on your computer. 

2.1 Install Software 
To install OBS onto your computer, please do the followings: 

i. Go to http://www.ahsay.com/en/download/download_customer_latest.html

ii. Download the corresponding version of the software you required, e.g. “Windows” -> “New 
Installation” 

iii. Download the “Installation and Upgrade Guide” 

iv. Follow the instructions in the “Installation and Upgrade Guide” to complete the installation  

2.2 Startup/Shutdown 
To startup/shutdown OBS, please do the followings: 

On Windows

i. Logon as [administrator] to Windows  

ii. Select the [Ahsay Offsite Backup Server] service from either: 

a. (For Windows NT)  [Control Panel] -> [Services]  

b. (For Windows XP)  [Control Panel] -> [Performance and Maintenance]  
-> [Administrative Tools] -> [Services]  

c. (For Windows 2000/2003)  [Control Panel] -> [Administrative Tools] -> [Services]  

iii. Startup/Shutdown 

a. To startup OBS, press the [Start] button 

b. To shutdown OBS, press the [Stop] button 

On Linux/Unix

iv. Logon as [root] 

v. To startup OBS , please run 

(Unix / Linux) [root]# /etc/init.d/obs start 
(FreeBSD) [root]# /usr/local/etc/init.d/obs start 

vi. To shutdown OBS, please run 

(Unix / Linux) [root]# /etc/init.d/obs stop 
(FreeBSD) [root]# /usr/local/etc/init.d/obs stop 

On Mac OS X

i. Logon as a Mac user with [administrative privileges] 

ii. To startup OBS, please do the followings by using [Applications] � [Utility] � [Terminal]  

[localhost:~] user1% su - 

http://www.ahsay.com/en/download/download_customer_latest.html
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Password: 
[localhost:~] root# SystemStarter start AhsayOBS  

iii. To shutdown OBS, please do the followings by using [Applications] � [Utility] � [Terminal]  

[localhost:~] user1% su - 
Password: 
[localhost:~] root# SystemStarter stop AhsayOBS 

2.3 Uninstall Software 
Please follow the following instructions to remove OBS from your computer: 

On Windows

iv. Logon as [administrator] to windows 

v. From [Control Panel] -> [Add or Remove Program] 

vi. Select the [Ahsay Offsite Backup Server] entry 

vii. Press the [Change / Remove] button 

viii. Press the [Uninstall] on the uninstall dialog 

ix. Remove the directory [C:\Program Files\Ahsay Offsite Backup Server] manually 

x. Remove all user backup and system files manually if they are not stored under OBS_HOME. 

On Linux/Unix

i. Logon as [root] 

ii. Shutdown OBS 

(Unix / Linux) [root]# /etc/init.d/obs stop 
(FreeBSD) [root]# /usr/local/etc/init.d/obs stop 

iii. Delete all files  
 

[root]# export OBS_HOME=/usr/local/obs 
 [root]# rm –rf $OBS_HOME 

iv. Remove all user backup and system files manually if they are not stored under OBS_HOME. 

On Linux/Unix

i. Logon as a Mac user with [administrative privileges] 

ii. Shutdown OBS, please do the followings by using [Applications] � [Utility] � [Terminal]  

[localhost:~] user1% su - 
Password: 
[localhost:~] root# SystemStarter stop AhsayOBS 

iii. Delete all files under [/Applications/AhsayOBS] 

iv. Remove all user backup and system files manually if they are not stored under OBS_HOME. 
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3 Quick Start 
This chapter describes the minimum steps required to start using OBS. Please consult the information in the 
following chapters for a complete reference to all features available in OBS.  

3.1 Getting started 
To setup your OBS, please do the followings: 

i. Point your browser to http://your-server/. 

ii. Logon to [Backup System Administration Logon] 
 
The default login name and password are “system” and “system” respectively. 
 

iii. Setup backup server 
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Prior to using OBS to backup your users’ data, please do the followings: 

a. Set your hostname 
 
Enter a resolvable hostname of your backup server (e.g. backup.your-company.com) into the 
[Host Name] text field. Although you can supply an IP address here, it is preferable to use a 
host name instead. 
 
Are you using custom TCP port? If so, try appending the custom port number to the [Host 
Name] field (e.g. backup.yourcompany.com:8080) 
 
If you are not using custom port, make open a browser on the backup server and type in the 
value of [Host Name] as an URL. Check if you get the backup server homepage. If you don't 
get the webpage, try until you can reach it and put this value in the [Host Name] field. 

b. Set the [User Homes] directory 
 
[User Homes] refers to directories where OBS stores the backup files and backup log for all its 
users. You should set [User Homes] to directories where there are lots of free spaces.  

c. Set your SMTP Server 
 
Enter a resolvable hostname (or an IP address) of your SMTP server into the [SMTP Server] 
text field 
 
If your SMTP server is not running on standard SMTP ports (i.e. port 25), you can append 
your custom port number to your SMTP server address to use this server (e.g. mail.your-
company.com:8025). 
 
You are only required to enter The [Login Name] and [Password] text fields if your SMTP 
server requires user authentication when sending emails 

d. Press the [Update] button 

e. Enter your license key (You can skip this step if you are evaluating this software) 
 
Enter the licensing information printed on [End User License Agreement] printout into the text 
field provided in the [Manage System] -> [Software License] panel. Please note that both 
[Licensee Name] and [License Key] are case sensitive. 
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iv. Add Backup User  
 
You need to add a backup user to the system before you can start backing up data to OBS. To add 
a backup user to the system, please do the followings: 

f. Click the [Manage User] link available at the top menu and choose [Add User] 

g. Enter the user information for the new user account into the form provided  
 

Key Description 
Login Name  Login Name of the new account 
Password Password of the new account 
Alias Another name of the new account 
Time zone Time zone of the new account 
Language Preferred language for email report of the new account 
Backup Client Choose OBM client or ACB client 
Advertise Group For ACB clients only. Choose whether advertisements are displayed at the bottom of the ACB client 
Type Trial User – Account of this type will be deleted from the system after an inactivity period of 30 days 

(max. quota of 500MB after 30 days trial period) 
Paid User - Account of this type will stay within the system until it is removed from the system by the 
administrator 

Email Email address of the new account 
Welcome email Check this option to send a welcome email 
User Home The top directory where the software stores backup files and all other information for the new account 
Backup Quota Backup Quota of the new account 
Bandwidth Bandwidth throttling for this user account 
Add-on modules Add-on modules for this user account 
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v. Logon as the new user 

a. Point your browser to http://your-server/. 

b. Click the [Backup User Logon] link 

c. Logon with the login name and password you have just created 

vi. Run Backup 
 
Please follow the [Quick Start] information available in the Users’ Guide to install the Online Backup 
Manager onto users’ computer to start backing up data. 
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4 Best Practices and Recommendations 
This chapter lists out all best practices and recommendations which you should consider before deploying OBS to 
a production environment. 

4.1 Setting [System Home] and [User Homes] to disk partition with 
large free space 

The default location of the [System Home] and [User Homes] settings are set to the system partition of a 
computer (i.e. C:\ or /usr). Since [System Home] and [User Homes] directories will be used to store application 
data (e.g. backup data, setting and log files), from a system performance point of view, it is not advisable to use 
the system partition of a computer to store application data. Before production, it is HIGHLY IMPORTANT to 
change the [System Home] and [User Homes] settings to a directory under a non-system partition to ensure the 
best overall performance and to avoid unexpected fill up of the system partition. 

4.2 Disk partitions larger than 500GB 
We recommend thorough testing on disk partitions larger than 500GB size before putting the system into 
production. It has been reported that that OBS starts running into strange unexplainable problems after using 
partitions over 500GB for a couple of months. After further investigations, we find out that some storage devices 
do have undocumented restrictions of running partitions with up to 1TB of storage. As it is impossible to find out 
which storage device has the limitation, to avoid unnecessary problems, we would recommend testing the system 
with partition large than 500GB thoroughly before going into production, though there are partners who have 
been using partitions over a few terabytes with no problem. 

Having a smaller partition has a number of other benefits as well, e.g. it is a lot faster to do a scandisk on a 
smaller partition. This helps reducing downtime when you need to do maintenance on your storage devices. Also, 
it is better not to put all eggs in one basket by storing everything in a single partition. If your data is spanning 
across different partitions, even if you lost one partition, data on other partitions are still safe. Furthermore, file 
addition and deletion add entries to the MFT (master file table) of the NTFS partition table which never gets 
cleaned up (similar overhead can be found be in Linux ext partition as well). Performance will degrade much 
faster on large partitions than on smaller partitions. 

4.3 Running OBS as non-root user 
If you are running OBS on Linux, you are advised to run the OBS service as non-root user. (OBS service is run 
under root by default). This minimizes the impact of damages that could be done on the system in case the 
system has been compromised by hackers. Please refer to the FAQ question of “How do I run OBS under non-
root user on Linux?” for detailed instructions of how to do so. 

4.4 Expose only TCP port 80 and 443 to the public 
It is recommended to expose only TCP port 80 and 443 to the public on your firewall. Please consult the user’s 
manual of your firewall for more information on how to do so. 
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5 Server Configuration 
This chapter describes how you can use the [Manage System] -> [Server Configuration] page (shown below) to 
manage the configuration of your backup server.  

This section describes all settings under the [Manage System] menu.  

 
Key Description 
Login Name / Password Username and password of system account 
Host Name A resolvable hostname of this server (e.g. backup.your-company.com). 

Although you can supply an IP address here, it is preferable to use a host 
name instead. 

System Home The directory where OBS stores its system information. The default 
directory for [System Home] is %OBS_HOME%\system. Normally, you 
don’t need to modify the value of this setting unless you want to store this 
information elsewhere. 

User Homes The directories where OBS stores the backup files and backup log for all its 
users. You should set [User Homes] to directories where there are lots of 
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free spaces. 
SMTP Server The SMTP server that OBS will use to deliver its email reports 
Report Sender The name and email address that will be used as a sender for all outgoing 

emails 
Administrative Contact The name(s) and email address(es) of the system administrator. System 

reports (e.g. Daily Usage Report and Daily Error Report) will be delivered 
to these mailboxes. 

Use Proxy Whether to use proxy to access the internet 
Proxy Host / Port Proxy server host and port number 
Proxy Username / Password Proxy user name and password if user authentication is used 
Language Setting It determines whether different languages are enabled 
Features Setting It determines whether the [FAQ], [Help], restore link and install link should 

be available to users 
File Permissions It determines whether the existing file are copied to retention area before 

updating the permission settings 

5.1 User Languages Setting 
The language of the web interface can be easily changed to another language by:  

i. Click the [Select Language] link available on the top right hand corner of the web interface 

ii. Select the language of your choice 

iii. All text messages from the original window are now displayed in the language you have just 
selected (see example below) 
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The languages currently supported by OBS include English, Czech, Danish, Dutch, French, Spanish, Portuguese, 
Icelandic, Norwegian, Finnish, Italian, German, Swedish, Chinese (Traditional and Simplified), Japanese, 
Lithuanian and Slovenian. You can limit the list of languages available to users by using the [Manage System] -> 
[Server Configuration] -> [Language Setting] options. 

If you uncheck all checkboxes for all languages available in [Manage System] -> [Server Configuration] -> 
[Language Setting], the [Select Language] will no longer be available on the top right and corner of the web 
interface (you need to refresh the top menu bar to see the change). Users will not be able to change the 
language of the web interface. 
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5.2 System Login Name/Password 
The [Login Name] and [Password] setting under the [Manage System] -> [Server Configuration] page sets the 
login name and password (the default username/password is system/system) that you would use to logon the 
system administration console. Users are recommended to change both the login name and password to 
something other than the default setting to avoid unauthorized access to the backup system. 

5.3 Host Name 
The [Host Name] setting under the [Manage System] -> [Server Configuration] page sets the hostname of the 
backup server. This entry will be used as a reference to the backup server in all email reports. Please enter a 
hostname/IP address (a public hostname/IP address if you expect backup requests originating from the internet). 

Also, please make sure that the [Host Name] entry is accessible from the backup server itself. This means that if 
you enter “backup.your-backup.com” into the [Host Name] entry, please make sure that when you enter 
“http://backup.your-backup.com” into the URL of a browser on the backup server itself, you can access the 
backup system welcome page. 

If you are running OBS on custom TCP port (i.e. NOT Port 80 and Port 443), please append your custom TCP port 
number to the [Host Name] entry. For example, if you are running OBS on TCP Port 8080 for HTTP, please enter 
“backup.your-backup.com:8080” as your [Host Name] entry (Please do not enter the custom TCP Port for HTTPS, 
e.g. 8443, into the [Host Name] field as it will not work). 

5.4 System Home and User Home Directories 
The [System Home] and [User Homes] setting under the [Manage System] -> [Server Configuration] page sets 
the system home directory and user home directories for OBS (the default values are “C:\Program Files\Ahsay 
Offsite Backup Server\system” and “C:\Program Files\Ahsay Offsite Backup Server\user” for Windows). 

The system home directory for OBS defines a directory in which OBS will store all its system information.  

The user home directories for OBS define a list of directories in which OBS can be used to store the user folder 
for each backup user. Each user folder contains the backup setting as well as all backup data owned by this 
particular user. 

Multiple user home directories can be set for OBS. This means that you can spread your users across different 
hard disk partitions (or different hard disks) and this will allow you to expand the storage available to OBS easily. 
For example, if you want to add more storage to OBS, you can simply add another hard disk (or NAS device) to 
the system and add the path to this new drive (e.g. E:\ or E:\Users) to the [User Homes] setting. You can then 
add new backup users (or move existing backup users) to this user home folder.  

Backup users created by OBM “Free Trial Registration” wizard will always use the first [User Homes] entry as the 
user home to create backup users. If you want to offer free trial to your users and have enabled the “Free Trial 
Registration” option on the [Manage System] -> [Server Configuration] page, please make sure that there is 
enough free space available in the first entry of the [User Homes] settings to avoid running out of free space. 
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Please also see “How do I set the user home directory to a network drive?” in the FAQ section.  

5.5 Email System Setting 
The [Email System Setting] settings under the [Manage System] -> [Server Configuration] page defines the 
various email setting OBS will use to generate email reports to backup system administrator and backup users. 

The [Email System Setting] -> [SMTP Server] -> [Host Name] entry defines the SMTP server that will be used by 
OBS to deliver its email reports. If you are using a SMTP server that is not running on SMTP standard TCP port 
(port 25), please append your custom TCP port number for SMTP service to the [SMTP Server] -> [Host Name] 
entry (e.g. mail.your-company.com:8025). 

You are only required to fill in the [SMTP Server] -> [Login Name] and [SMTP Server] -> [Password] entry if the 
SMTP server you are using required user authentication before accepting mail delivery requests. 

Multiple SMTP servers can be setup for OBS. If the first SMTP server is unavailable, the next SMTP server will be 
used. 

The [Email System Setting] -> [Report Sender] entry defines the “Mail-From” email address that appears in all 
outgoing emails generated by OBS.  

The [Email System Setting] -> [Administrator Contact] entry defines the administrative contact of OBS. OBS will 
send daily usage and error report and all critical system alert to all email addresses defined here.  

5.6 Proxy Setting 
The [Use Proxy] settings under the [Manage System] -> [Server Configuration] page defines whether OBS should 
use a proxy to gain access to the internet. 

Two types of proxy, HTTP/HTTPS and SOCKS 4/5, are supported. You can use the [Proxy Host] and [Port] entries 
to define the location of your proxy server. If the proxy server you are using requires user authentication, please 
use the [Proxy Username] and [Proxy Password] entries to set the username/password for your proxy server. 

5.7 Features Setting 
The [Features Setting] settings under the [Manage System] -> [Server Configuration] page defines whether 
some customizable features on the web interface should be enabled or not. 

Key Description 
Show FAQ link  It defines whether the [FAQs] link should appear at the top right hand corner of the 

web administration console (user interface only) 
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Show Help link It defines whether the [Help] link should appear at the top right hand corner of the 
web administration console (user interface only) 

Show Restore Link It defines whether the [Restore] link should appear at the top right hand corner of 
the web administration console (user interface only) 

Show Install Link It defines whether the [Install Software] link should appear at the top right hand 
corner of the web administration console (user interface only) 

5.8 File Permissions 
The [File Permissions] settings under the [Manage System] -> [Server Configuration] page defines whether OBS 
should make a copy of the file to the retention area before the file permission changes. When this option is set, 
all backup accounts will use more retention space but allows the users to restore the same file with various 
permissions. When this option is not set, the permission changes are updated to the backed up file directly. 

5.9 Free Trial Setting 
The [Enable Free Trial Registration] settings under the [Manage System] -> [Server Configuration] page defines 
various free trial settings available in OBS. 

Trial users do not count towards the maximum number of users allowed within OBS by the software license and 
there can be unlimited number of trial users within OBS. However, each backup user can have a maximum 
backup quota of 100GB for a trial period of 30 days. After expiration of the trial period, the backup quota will 
reset to a maximum of 500MB automatically. 

To allow backup accounts to be created from OBM upon installation of OBM (if no backup account can be found 
on the system), please enable the [Enable Free Trial Registration] option. If this checkbox is unchecked, the 
option to register for a trial account (see below) will not be available to users. 

The [Backup Quota] defines the maximum backup quota of trial backup accounts upon registration.  

The [Add-on Modules] option defines whether you want to allow trial users to have different add-on modules. 

The [Remove User] option defines whether you want to remove trial backup users for certain number of days 
after registration. For example, you can use this option to tell OBS to remove trial backup users from the system 
automatically after backup users have registered for 60 days. 



We back up your business 
Ahsay Offsite Backup Server v5.2

Administrator’s Guide

Ahsay Systems Corporation Limited Page 22 of 85 (April 15, 2008)

6 Software License 
This chapter describes how you can use the [Manage System] -> [Software License] page (shown below) to 
manage software license of OBS. 

Key Description 
Licensee Name Business name of the licensee 
License Key License Key to activate this software. Please enter [License Key] as printed on the 

[Software License Agreement] into the text field provided. 
Number of users The maximum number of OBM and ACB backup accounts allowed. 
Add-on Modules It shows whether different add-on modules are enabled. You need to have a new 

license key to enable these modules. 
� Quota – the total number licenses of a particular module available in total 
� Used – the total number licenses of a particular module assigned to all users 
� Available – the total number licenses of a particular module available for further  

Product Name Name of the licensed product 
Product Version Version number of the licensed product 
Expiry Date The date when the current license key will expire. You will not be able to use OBS this 

date. 
Free Upgrade Until The last date you are allowed to upgrade to the latest OBS available. You will not be 

able to upgrade to software release after this date with your current license key. You 
will still be able to use existing running software with this license key. 

Max Quota The maximum quota for each backup user supported. 
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6.1 Licensee Name and License Key 
When you click the [Manage System] -> [Software License] link available at the top menu, the [Software License] 
panel will appear (see above). You can use the form available on this panel to activate the software. 

Please remember the following notes when you enter your licensee name and your license key: 

� Both [Licensee Name] and [License Key] are case sensitive and they must be entered EXACTLY as stated 
in your software receipt. If possible, please use copy and paste shortcuts (CTRL-C and CTRL-V) to enter 
both the [Licensee Name] and [License Key] into the field provided to avoid typo error. 

� If a proxy server is required to access the Internet from OBS, please setup the proxy setting. Access to 
the Internet is required because the license key must be activated by our license server before it is 
usable. 

� One license key can only used on one machine once it has been activated. If you use the same license 
key to activate another copy of OBS on another server, you will get an “Internal Error 1011” message. 
You can still run this copy of OBS for another 7 days without any problems but it will stop working after 
this grace period. Please contact us to re-activate your license key if you run into this situation. 

6.2 Automatic License Renewal 
If you are using OBS under a monthly leasing plan, you will be given a license key that will run only for 30 days 
(expiry date in the next 30 days). Upon expiration, your license key will be renewed automatically. This means 
that even if you have a license key that will expire in no more than 30 days, the license key will be renewed 
automatically and no user intervention is required to make it happen. 

If there is anything wrong with the license renewal process (e.g. our license server is down or the network 
connection is unavailable), expired license will have a grace period of 14 days to renew its license key. This 
means that OBS could still function with expired license for an extra 14 days before it shutdowns itself. Hopefully, 
a grace period of 14 days should be enough to resolve any problems arising from the automatic license renewal 
process. 
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7 Managing Routine Job 
This chapter describes how you can use the [Manage System] -> [Routine Job] page (shown below) to manage a 
number of system routine jobs of OBS. When you click the [Manage System] -> [Routine Jobs] link available at 
the top menu, the [Routine Jobs] panel will appear. You can use the form available on this panel to define your 
preferences of how you want different system routine jobs to run. 

Key Description 
Backup Report Hourly job sending backup reports to users whose backup job have completed 

within the last hour. 
Online Restore Report Hourly job sending online file restoration reports to users who have performed 

and completed an online file restoration action within the last hour. 
Setting Change Report Hourly job sending setting change reports to users who have updated their 

backup setting within the last hour. 
Missed Backup Report Hourly job checking whether any scheduled backup job has been missed for all 

backup users and sending missed backup reports to users who have missed 
their backup jobs. 

Inactive User Report Daily job sending inactive user reports to users if their accounts have been 
inactive for more than 7 days. 

Off-line Backup Reminder Daily job sending off-line backup reminders to users who have set the off-line 
backup option and have not performed a backup for the required number of 
days. 

Backup Quota Reminder Daily job sending backup quota reminders to users whose storage quotas are 
above a certain percentage. 

Trial User Reminder Daily job sending trial user reminders to users whose trial account are about to 
expire. 

Usage Report Daily job sending system usage reports to system administrators. 
Error Report Daily job sending system error reports to system administrators. 
Inactive User Removal Daily job deleting all trial accounts that have been inactive for 60 days. 
Retention Policy Job Daily job removing obsolete files from the retention area according to each 

user's retention policy setting. 
Rebuild User Storage Weekly job rebuilding all users' storage information by walking through all 

users' backup files. 
System Log removal Daily job removing system logs older than this number of days from the system
Debug Log Removal Daily job removing debugging logs older than this number of days from the 
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system. 

7.1 Backup Report 
The [User Report] -> [Backup Report] setting under the [Manage System] -> [Routine Job] page defines the 
setting of the [Backup Report] routine job. The role of the [Backup Report] routine job is to send backup reports 
to users who have finished one of their backup jobs within the last hour.  

This job runs at the start of every hour. If you want your users to receive these reports, please select the [Enable] 
option. Otherwise, select the [Disable] option. 

7.2 Online Restore Report 
The [User Report] -> [Online Restore Report] setting under the [Manage System] -> [Routine Job] page defines 
the setting of the [Online Restore Report] routine job. The role of the [Online Restore Report] routine job is to 
send online file restoration reports out to users who have performed and completed an online file restoration 
action within the last hour.  

This job runs at the start of every hour. If you want your users to receive these reports, please select the [Enable] 
option. Otherwise, select the [Disable] option. 

7.3 Setting Change Report 
The [User Report] -> [Setting Change Report] setting under the [Manage System] -> [Routine Job] page defines 
the setting of the [Setting Change Report] routine job. The role of the [Setting Change Report] routine job is to 
send reports out to users who have updated their profiles or backup sets within the last hour.  

This job runs at the start of every hour. If you want your users to receive these reports, please select the [Enable] 
option. Otherwise, select the [Disable] option. 

7.4 Missed Backup Report 
The [User Report] -> [Missed Backup Report] setting under the [Manage System] -> [Routine Job] page defines 
the setting of the [Missed Backup Report] routine job. The role of the [Missed Backup Report] routine job is to 
send reminder notice to users who have missed one of their scheduled backup jobs. OBS defines a scheduled 
backup job to be a missed backup job if there is no backup run 6 hours after a backup has been scheduled. 

This job runs at the start of every hour. If you want your users to receive these reports, please select the [Enable] 
option. Otherwise, select the [Disable] option. 

7.5 Inactive User Report 
The [User Report] -> [Inactive User Report] setting under the [Manage System] -> [Routine Job] page defines 
the setting of the [Inactive User Report] routine job. The role of the [Inactive User Report] routine job is to send 
a reminder notice to users who have been inactive on the system.  

This job will run daily as defined by the [Daily at] setting. If you want your users to receive these reports, please 
select the [Enable] option. Otherwise, select the [Disable] option. 

7.6 Off-line Backup Reminder 
The [User Report] -> [Off-line Backup Reminder] setting under the [Manage System] -> [Routine Job] page 
defines the setting of the [Off-line Backup Reminder] routine job. The role of the [Off-line Backup Reminder] 
routine job is to send a reminder notice to users who have set the off-line backup option in their backup sets but 
failed to backup for a certain amount of time. 

This job will run daily as defined by the [Daily at] setting. If you want your users to receive these reports, please 
select the [Enable] option. Otherwise, select the [Disable] option. 
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7.7 Backup Quota Reminder 
The [User Report] -> [Backup Quota Reminder] setting under the [Manage System] -> [Routine Job] page 
defines the setting of the [Backup Quota Reminder] routine job. The role of the [Backup Quota Reminder] routine 
job is to send a reminder notice to users whose storage quota usage has hit a pre-defined percentage. 

This job will run daily as defined by the [Daily at] setting. If you want your users to receive these reports, please 
select the [Enable] option. Otherwise, select the [Disable] option. Please also set the pre-defined percentage of 
storage divide by quota that will trigger this reminder. 

7.8 Trial User Reminder 
The [User Report] -> [Trial User Reminder] setting under the [Manage System] -> [Routine Job] page defines 
the setting of the [Trial User Reminder] routine job. The role of the [Trial User Reminder] routine job is to send a 
reminder notice to users whose trial accounts are about to expire. 

This job will run daily as defined by the [Daily at] setting. If you want your users to receive these reports, please 
select the [Enable] option. Otherwise, select the [Disable] option. Please also set the number of days after 
registration that the users should get this reminder. 

7.9 Usage Report 
The [System Report] -> [Usage Report] setting under the [Manage System] -> [Routine Job] page defines the 
setting of the [Usage Report] routine job. The role of the [Usage Report] routine job is to send usage report, 
which contains a statistics of all backup users activities, to the administrative contacts of OBS. 

This job will run daily as defined by the [Daily at] setting. If you want the administrative contacts of OBS to 
receive the usage report, please select the [Enable] option. Otherwise, select the [Disable] option. 

7.10 Error Report 
The [System Report] -> [Error Report] setting under the [Manage System] -> [Routine Job] page defines the 
setting of the [Error Report] routine job. The role of the [Error Report] routine job is to send error report, which 
contains a full listing of all system and backup errors, to the administrative contacts of OBS. 

This job will run daily as defined by the [Daily at] setting. If you want the administrative contacts of OBS to 
receive the error report, please select the [Enable] option. Otherwise, select the [Disable] option. 

7.11 Inactive User Removal 
The [System Job] -> [Inactive User Removal] setting under the [Manage System] -> [Routine Job] page defines 
the setting of the [Inactive User Removal] routine job. The role of the [Inactive User Removal] routine job is to 
remove inactive trial users (i.e. no logon or backup traffic from this user) from OBS as defined by the Free Trial 
Setting.

This job will run daily as defined by the [Daily at] setting. If you want this job to run, please select the [Enable] 
option. Otherwise, select the [Disable] option. 

7.12 Retention Policy 
The [System Job] -> [Retention Policy] setting under the [Manage System] -> [Routine Job] page defines the 
setting of the [Retention Policy] routine job. The role of the [Retention Policy] routine job is to delete files from 
the retention area for each user according to the retention policy of each backup set of each backup user. 

This job will run daily as defined by the [Daily at] setting. If you want this job to run, please select the [Enable] 
option. Otherwise, select the [Disable] option. 

The [Enable File Validation] option defines the setting of whether backup files will be validated for integrity while 



We back up your business 
Ahsay Offsite Backup Server v5.2

Administrator’s Guide

Ahsay Systems Corporation Limited Page 27 of 85 (April 15, 2008)

running retention policy: 

� [Filesize & Checksum] – check both file size and checksum number to validate file integrity 

� [Filesize only] –check only the file size to validate file integrity. Checksum is not checked in this case to 
make validation run faster 

� [Skip Validated File] – Skip validating a backup file if it has been validated already by a previous validation 
job 

� [Log Information Only] – If a file fails to pass the validation check, a message will be logged in the 
[Manage Log] -> [System Log] log. In this case, this file will still be residing in the user directory as valid 
backup file, though it is likely that it can’t be restored successfully 

� [Move to retention dir] –If a file fails to pass the validation check, a message will be logged in the 
[Manage Log] -> [System Log] log and this file will be moved from the user directory ([User Home] \ 
[Login Name] \ files) to the retention directory ([User Home] \ [Login Name] \ errfiles). In this case, this 
backup file will be uploaded from the client’s computer to the backup server next time when this user runs 
a backup job. 

7.13 Rebuild User Storage 
The [System Job] -> [Rebuild User Storage] setting under the [Manage System] -> [Routine Job] page defines 
the setting of the [Rebuild User Storage] routine job. The role of the [Rebuild User Storage] routine job is to 
recalculate all users’ storage information (e.g. data area file size/number, retention area file size/number) by 
traversing through all backup files for all users within the system. 

This job is designed to run weekly and will run at the time defined by the [Every WEEKDAY at] setting. If you 
want this job to run, please select the [Enable] option. Otherwise, select the [Disable] option. 

7.14 System Log Removal 
The [System Job] -> [System Log Removal] setting under the [Manage System] -> [Routine Job] page defines 
the setting of the [System Log Removal] routine job. The role of the [System Log Removal] routine job is to 
remove all system logs (i.e. all information under the System Home, e.g. system error logs or backup error logs) 
from OBS after the [Keep Logs for] number of days. 

This job is designed to run daily and will run at the time defined by the [Daily at] setting. If you want this job to 
run, please select the [Enable] option. Otherwise, select the [Disable] option. 

7.15 Debug Log Removal  
The [System Job] -> [Debug Log Removal] setting under the [Manage System] -> [Routine Job] page defines the 
setting of the [Debug Log Removal] routine job. The role of the [Debug Log Removal] routine job is to remove all 
debugging logs (e.g. access logs and web application context logs) from OBS after the [Keep Logs for] number of 
days. 

This job is designed to run daily and will run at the time defined by the [Daily at] setting. If you want this job to 
run, please select the [Enable] option. Otherwise, select the [Disable] option. 
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8 Managing Replication 
Please refer to the Installation and Upgrade Guide for Ahsay Replication Server for information on how to 
installation the Replication Server (RPS) to work with OBS. For further information, please refer to the Ahsay 
Replication Server Administrator’s Guide.

http://www.ahsay.com/download/customer/document/guide_rps_admin.pdf
http://www.ahsay.com/download/customer/document/guide_rps_admin.pdf
http://www.ahsay.com/download/customer/document/guide_rps_inst-upg.pdf
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9 Managing ACB Configuration 
This chapter describes how you can use the [Manage System] -> [ACB Config] page (shown below) to manage 
the advertisements and default In-file delta setting for all ACB users. 

Key Description 
In-file delta setting for all 
ACB users 

Select this option to enable and use in-file delta technology for all ACB clients 

Block Size The in-file delta block size used to detect changes within a file. A smaller block 
size should produce a smaller delta file but requires more processing power. 
The default setting of [Auto] will choose the optimal block size for each file 
based on the file’s original file size. 

Minimum Size The minimum size setting defines the smallest file size to apply the in-file delta. 
In-file Delta Type The in-file delta type to use for calculating the delta file 

� Incremental – this option uses the previous uploaded full or incremental file 
to calculate the delta. It produces the smallest delta for upload but requires 
the most time and processor power to restore. 

� Differential – this option always uses the latest uploaded full file to calculate 
the delta. It produces a larger delta but allows for the fastest restore. 

Upload Full File The upload full file setting determines when the full file should be uploaded to 
the server instead of the delta. It depends on either of the following rules being 
true: 
� Maximum No. of Delta – the total number of deltas uploaded since the last 

full file. The default setting is 100 deltas. 
� Delta Ratio – the ratio of the Delta Size divided by the Full file size. The 

default setting is 50%. 
Advertisements Click the [Add] link to add new advertisements 

9.1 In-file Delta Settings for all ACB users 
The [In-file delta settings for all ACB users] setting under the [Manage System] -> [ACB Config] page defines a 
global setting for all ACB clients. Select this option to enable In-file Delta Technology for ACB clients. 
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9.2 Block Size 
The [Block Size] setting defines the size of data block being used to detect changes between the last full backup 
file and the file being backed up. In general, the smaller the block size, the more likely a matched data block can 
be found, hence produces a smaller delta file but require more processing power to detect these changes. On the 
other hand, in-file delta backup running with a larger block size will run faster but this will generally produce a 
larger delta file. 

In most case, the default setting [Auto] will choose the optimal block size for each file (depending on the size of 
the file) for you. 

9.3 Minimum Size 
The [Minimum Size] setting defines the smallest file size a file must have before the use and application of in-file 
delta backup technology. 

If the size of a file that is being backed up is smaller than the [Minimum File Size] setting, in-file delta backup 
technology won’t be applied to this file and the whole file, instead of just the delta file, will be uploaded to the 
backup server. It is not necessary to perform in-file delta backup on small files because backing up the whole file 
doesn’t take too long anyway. Backing up the whole file instead reduces the time required to restore a backup file. 

9.4 In-file Delta Type 
The [In-file Delta Type] setting defines the way in-file delta files are handled. There are two different versions as 
follows: 

 

Incremental in-file delta type

All delta files are generated with respect to changes made since the last incremental backup. This means that the 
last full backup file and ALL incremental delta backup files are required to restore the latest snapshot of a backup 
file.  

The full backup file, its checksum file and all incremental delta files stored on the server are always stored in the 
data area. This means that these files are not affected by the setting of the retention policy and will always be 
kept on the backup server. It is done this way because all these files are required to get the latest snapshot of 
the backup file and they should not be removed from the backup server by the retention area cleanup routine. 

 

Differential in-file delta type

All delta files are generated with respect to changes made since the last full backup file (i.e. differential backup). 
This means that only the last full backup file and the last delta file are required to restore the latest snapshot of a 
backup file. This means that other intermediate delta files are only required if you want to restore other 
snapshots of a backup file. 

Differential in-file delta backup has the benefits that a corrupted delta file would only make one particular version 
of a backup file non-recoverable and all other backups created by other delta files of the same file would still be 
intact. 

The full backup file, its checksum file and the last delta file uploaded (if more than one delta files have been 
uploaded to the backup server) is always stored in the data area. This means that these files are not affected by 
the setting of the retention policy and will always be kept on the backup server. It is done this way because all 
these files are required to get the latest snapshot of the backup file and they should not be removed from the 
backup server by the retention area cleanup routine. All other intermediate delta files are stored in the retention 
area. 

 

9.5 Upload Full File 
The [Upload Full File] setting defines when to upload a full file instead of a delta file. 
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No. of Delta

The [No. of delta] setting defines the maximum number of delta files from the same full backup file to be 
generated and backed up to the backup server before a full backup (the whole file) of this file is uploaded to the 
backup server instead.  

For example, if you have created 100 delta files from the full backup file already and the [No. of delta] setting is 
set at 100, the next backup will upload a full backup file (the whole file) instead of just the delta file. However, if 
the [No. of delta] setting is unlimited, it will keep generating delta files and uploading these delta files to the 
backup server until the other delta setting condition (delta ratio exceeded) forces a full backup. This setting is 
here to make sure that there will always be a full backup file after a certain number of delta files have been 
generated. 

Delta Ratio

The [Delta Ratio] setting is defined as the size of a delta file divided by the size of its full backup file (i.e. the 
percentage of changes detected between the last full backup file and the current file).  

If the delta ratio calculated from the size of the generated delta file and the size of the full backup is greater than 
the [Delta Ratio] setting, the whole file, instead of just the delta file, will be backed up to the backup server. It is 
done this way because the difference between backing up the whole file and the delta file is not significant and it 
is better to upload the whole file instead. 

The default setting of [Delta Ratio] is 50%. This means that if the changes detected within a file are more than 
50%, the whole file, instead of the delta file will be backed up and uploaded to the backup server.  

 

9.6 Advertisements 
The [Advertisements] setting defines the advertisements and related information that is displayed at the bottom 
of all ACB clients. 
 

Key Description 
Add Click this link to add a new advert. 
Show Advertisement Log Click this link to view the advertisement log. 
Name The name of the advertisement. Click the link to edit this advert. 
Text The text to be displayed at the bottom of the ACB client. 
Start Date The date when this advert was created. 
Popularity Calculated value to indicate which advert is the most popular. The value is 

calculated as the percentage of [Hits for this advert] divided by [Total Hits]. 
Hits The “Hits” counter indicates the number of times this advert has been clicked. 

These counters are only updated if the option “Enable Tracking” is set. The 
three values are [Hits within 1 day] / [Hits within the last 7 days] / [Hits within 
the last 30 days]. 

Time The number of seconds to display the advert. 
Move The display sequence of the adverts. 
Target Click this link to test the advertisement’s URL. This will open a browser and 

displays the URL web page. 
Remove Click this link to delete the advert. 
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Add New Advertisement

Click the [Add] link to add new advertisements. Enter the advert information into the form provided. 
 

Key Description 
Name The name of the advertisement. 
Image The full pathname of the image file to be displayed at the bottom of the ACB 

client. The image size should be 468 x 60. 
Text The text to be displayed at the bottom of the ACB client. 
Text Animation Setting to define whether the text should scroll. 

� Scroll Left – text scrolls from right to left. 
� Scroll Right – text scrolls from left to right. 
� None – do not scroll text. 

Text Alignment Setting to define the text alignment. 
� Left – text is aligned left. 
� Center – text is centered. 
� Right – text is aligned right. 

URL The URL of the advert. If the user clicks the advert in ACB, a browser will open 
and displays this web page. 

Enable tracking When selected, every time the user clicks the advert in the ACB client, a “Hits” 
counter is incremented. 

Seconds The number of seconds to display the advert. 
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10 Managing User 
This chapter describes how you can use all pages under the [Manage User] menu to manage the backup users 
within OBS. 

10.1 Create Backup User 
When you click the [Manage User] -> [Add User] link available at the top menu, the [Add User] form will appear 
(see below). You can then add a backup user to the system by submitting this form to OBS. 

A description of all fields above is provided in the following table. 

Key Description 
Login Name  Login Name of the new backup user 
Password Password of the new backup user 
Alias Another name of the new backup user 
Time zone Time zone of the new backup user 
Language Preferred language for all email reports of the new backup user 
Backup Client Choose OBM client or ACB client 
Advertise Group For ACB clients only. Choose whether advertisements are displayed at the bottom of 

the ACB client 
Account Type Either [Trial] or [Paid] type. Trial accounts and paid users differ in the following ways: 

 
1. Trial users can only have a maximum backup quota of 500MB after the trial period.
2. Trial users subject to automatic removal as defined by the [Free Trial Registration] 

setting (though automatic removal can be disabled) 
 
Other than the differences listed above, both trial and paid users are the same in all 
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other areas. 
 

Email Email address of the new backup user 
Welcome email Define whether a welcome email should be sent to the new user email address 
User Home The top directory where the software stores backup files and all other information for 

the new account. If you want this user to be in another partition (or in another drive), 
please add another user home to OBS by using the [Manage System] -> [System 
Configuration] page. 
 
If you want to setup your user home directories to a network drive, please do refer to 
our FAQs section for more information. 

Backup Quota Backup Quota of the new account 
Bandwidth Bandwidth allowed for the new account 
Add-on Modules Whether to enable any of the add-on modules to the new backup user 

 
The [Microsoft Exchange Mailbox] text field defines the number of exchange mailboxes 
that’s allowed to be backed up under this user account 

10.2 List / Remove Backup User 
When you click the [Manage User] -> [List User] link available at the top menu, the [List User] panel will appear. 
You can use the alphabet categories at the top of the user listing to limit the listing to show only those users 
whose login names starting with a certain alphabet. You can also use the [All] function available to list all users 
within the system.  

To remove a user from the system, just press the [Remove] link next the user you would like to remove. 

Key Description 
Search By Define whether alphabetically search should be applied to [Login Name] or 

[Alias] 
User Add-on modules Indicates the add-on modules for this account 
Backup Client Indicates the backup client for this account 
Login Name  Login Name of this account. Click the link to see account details 
Alias Alias of this account 
Registration Date Date when this account was created 
Used/Quota (%) The used/allocated quota (and the quota usage percentage) of this backup user.
Remove Remove this backup user 
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Broadcast Message Use this option if you want to broadcast messages to backup users 

10.3 Broadcast messages to backup users 
After you press the [Broadcast Message] link on the top right hand corner of the [Manage User] -> [List User] 
panel, you will be brought to the [Broadcast Message] page. You can use this page to broadcast messages to 
different types of backup users. 

Key Description 
From Sender of this message 
To Broadcast message to the following user types: 

� All – all backup users  
� Paid – backup users of [Paid] user type 
� Trial – backup users of [Trial] user type 
� OBM User – backup users of OBM client type 
� ACB User – backup users of ACB client type 
� Admin – backup administrator, i.e. email address defined on the [Manage System] 

-> [Server Configuration] -> [Administrator Contact] list (useful if you want to test 
the broadcast feature before sending the message out to all users) 

Subject Subject of this message 
Message Content of this message 
Text/Html The content type of this message, i.e. whether content should be considered as plain 

text or HTML. 
Attachment A file to be broadcasted with this message 

10.4 Managing User Profile 
After you press the user name link on the [Manage User] -> [List User] panel, you will be brought to the [User 
Profile] panel for this particular user. You can use this panel to update the profile of this user. 
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This panel is no different to the [User Profile] panel that users will see when they logon to the user area except 
that you can now update the [Type], [Quota] and [Add-on Module] (shown in RED) entries on this page. 

Click the [File Validation Option] link to rebuild this user’s storage information. 

You can reset a user password by applying a new password to [User Profile] -> [Password] -> [New] entry and 
press the [Update] button. Before the user logon to OBS using OBM, both old and new passwords are valid. It is 
designed this way because a copy of the user’s password is saved on the client machine for the backup scheduler 
to use to run scheduled backups. It is important to allow the old password to be valid until the new password is 
saved the on client machine when user logon to OBM with the new password. 

The [Microsoft Exchange Mailbox] text field defines the number of exchange mailboxes allow to be backed up 
under this backup account. The [Max] message indicates the maximum number remaining licenses available. 
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The [Bandwidth] option allows you to set a maximum network usage for all running backup sets of this particular 
backup account. All backup sets will share the same bandwidth defined by this setting. If you have set the 
bandwidth to be 128kbits/second and there are two backup sets running at the same time, each backup set will 
share roughly half of the bandwidth assigned, i.e. 64kbits/seconds. 

The [Notes] field allows you to attach some other information, e.g. telephone number or billing address, with this 
backup account. 

10.5 Managing Backup Set 
After pressing the [Detail] button next to a user on the [Manage User] -> [List User] panel, a [Backup Set] link is 
now available in the extended user menu. You can review the backup sets setting of this particular user by 
clicking the [Backup Set] link.  

To update the backup set setting of this particular user, just make the required changes on the form below and 
press the [Update] button. 

Setting Online Restore IP Restriction

At the bottom of the [Backup Set] panel, you should be able to find the [Online Restore IP Restriction] section. If 
you would like to restrict online file restore of this backup set to only a subset of trusted IP addresses, you just 
need to enter the trusted IP addresses here. Once you have entered some IP addresses into the IP restriction list, 
online file restore request originating from IP addresses not listed on this list will no longer be able to restore any 
files from this backup set. (You can use the IP range of 127.0.0.1 – 127.0.0.1 to disable online restore 
completely) 
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10.6 Browsing User Backup File 
You can click the [File Explorer] link available at the extended [Manage User] menu to invoke the [File Explorer] 
panel. You can use this panel to browse and restore user’s backup files. This panel is the same [File Explorer] 
panel that users would see when they click the [File Explorer] link after they have logged on to the system. 
Please refer to the User’s Guide for information on how to restore user’s backup files. 

10.7 Reviewing User Backup Report 
You can click the [Report] link available at the extended [Manage User] menu to invoke the [Report] panel. You 
can use this panel to review users’ backup activities. This panel is the same [Report] panel that users would see 
when they click the [Report] link after they have logged on to the system. Please refer to the User’s Guide for 
information on how to review users’ backup activities. 
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10.8 Reviewing User Storage Statistic 
You can click the [Statistics] link available at the extended [Manage User] menu to invoke the [Statistics] panel. 
You can use this panel to review users’ storage statistics. This panel is the same [Statistics] panel that users 
would see when they click the [Statistics] link after they have logged on to the system. Please refer to the User’s 
Guide for information on how to review users’ storage statistics. 
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11 AutoUpdate 
This chapter describes how you can use the AutoUpdate feature to deliver update of OBM to all running instances 
of OBM automatically.  

11.1 How it works 
AutoUpdate works in the following sequences:  

i. Backup scheduler running on the client machine will download the index file 
(%INSTALL_DIR%\webapps\obs\liveUpdate\index.xml) which contains the information of the latest 
client software available from this backup server 

ii. If the backup scheduler finds out that OBS contains a patch for OBM which is more recent than the 
one running on its own machine, it will download and install the patch from OBS automatically 
(%INSTALL_DIR%\webapps\obs\liveUpdate\obm????.zip) 

iii. Scheduled backup now run with the latest version of OBM 

As you can see from the steps above, AutoUpdate relies on backup scheduler to function properly. No new 
updates will be delivered to a machine running OBM if backup scheduler is not enabled or no scheduled backup 
has been run since a new update has been installed on OBS. 

11.2 Using AutoUpdate 
When you install an updated version of OBS on your backup server, a new version of the AutoUpdate module for 
OBM is already bundled with the updated version of OBS. This means that a new version of OBM will be delivered 
to all your client machines through AutoUpdate when you install an updated version of OBS on your server. 

11.3 Customizing AutoUpdate 
If you want to customize the AutoUpdate patch file that will be delivered to your existing client installations (i.e. 
sending your own patch file to your client), please do this:  

i. Find the "%INSTALL_DIR%\webapps\obs\liveUpdate\obm????.zip" file on the running OBS 

ii. Expand obm????..zip to a directory 

iii. Replace all *.properties files with your customized version (these files can be generated from 
“%INSTALL_DIR%\properties.xls” easily) 

iv. Replace all *.gif files with your customized version 
 
The following is some common files that you are likely to customize: 

a. OBMLogo.gif – This is the image file used as the Windows icon for OBM  

b. aboutBG.gif – This is the image file used in the [View] -> [About] dialog box 
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v. Replace all *.ico files with your customized version  
 
The animation produced when backup is running, i.e. the "running arrow", is made up by showing 
icon1.ico, icon2.ico, icon3.ico and icon4.ico in sequence. You can change the animation by replacing 
these files by your own files (in fact, you can use more than 4 ICO files for your animation. Just 
make sure they are named in consecutive sequence as you want the images to be rotated). 

vi. Zip all files back to obm????.zip (make sure all files are under the "bin" directory within the zip 
archive as shown below) 
 

vii. Finish 

11.4 Forcing an extra AutoUpdate 
If you want to customize the AutoUpdate patch file that will be delivered to your existing client installations (i.e. 
sending your own patch file to your client), please do this:  

i. Find the "%INSTALL_DIR%\webapps\obs\liveUpdate\index.xml" file on OBS 

ii. Modify the line 
 
<Update version="x.x.x.x" url="/obs/liveUpdate/obm????.zip" crc="-1" last-modified="0" size="-
1" />  
 
to 
 
<Update version="x.x.x.xa" url="/obs/liveUpdate/obm????a.zip" crc="-1" last-modified="0" 
size="-1" /> 
 
Please note that there is an “a” character appended to both the version and url attributes. 

iii. Make change to the AutoUpgrade file, [obm????.zip], as required and rename it to [obm????a.zip] 

iv. Backup scheduler on the client machine will consider version “x.x.x.xa” to be a more recent release 
of OBM and will download the AutoUpgrade file, /obs/liveUpdate/obm????a.zip, before starting the 
next scheduled backup.  
 
If you need to force another extra AutoUpdate again, just redo all previous steps using the letter 
“b” instead of the letter “a”. The new AutoUpdate file /obs/liveUpdate/obm????b.zip, in this case, 
will be delivered to the client machine automatically before the next scheduled backup starts. 
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12 Backup / Restore files using off-line media 
Backing up large amount of files (e.g. 300GB) online through the Internet is a very lengthy task. It is sometimes 
necessary to ship the first full backup through offline media (e.g. removable USB hard disk) to the backup server. 
Once the first full backup is loaded onto the backup server through offline media, all subsequent backups will be 
able to run and complete successfully in a timely manner because it is only necessary to upload new/updated files 
to the backup server. 

Restoring large amount of files (e.g. 300GB) online through the Internet is also a very lengthy process. It is also 
important to be able to allow users to restore their backup files through offline media to reduce the time required 
to restore large amount of files. 

This chapter describes the steps required to import/export backup files to/from OBS. 

12.1 Seed loading backup files (Import) 
A backup user can use the [Seed Load Utility] to transport its first full backup to an offsite backup server without 
having to upload a large volume of data through the Internet (Please refer to the User’s Guide for more 
information). When the seed load files are transported to the backup server (e.g. using removable hard disk), 
please follow the instructions below to install them into the required user account: 

i. Locate the home directory of the backup user 
 
A backup user’s home directory is a directory named the login name of the backup user under one 
of the OBS’s [User Homes] directories. [User Homes] is a system-wide setting which can be 
accessed under the [Manage System] menu after logging onto the web system management 
console.  
 
For example:  
 
The default [Users Homes] directory is “C:\Program Files\Ahsay Offsite Backup Server\user”. If the 
login name of the backup account is “john”, the home directory of user “john” should be 
“C:\Program Files\Ahsay Offsite Backup Server\user\john” 

ii. Copy all seed load files to the home directory 
 
Find the “files” directory from the seed load files, and copy the “files” directory to the backup user’s 
home directory.  
 
In this example, you should copy the “files” directory to “C:\Program Files\Ahsay Offsite Backup 
Server\user\john” 
 
If you are running OBS on Linux under a non-root user (e.g. obs), please make sure that the “files” 
directory and all its contents are owned and writable by the user running OBS (e.g. obs). 

iii. Check if all files are installed correctly 
 
Logon to the web interface of OBS with the backup user account (“john” in this example) and click 
the [File Explorer] link available at the top of the menu. Check if you can see all seed load files 
correctly installed. 

iv. Total number of files and total file size imported into the data area through seed loading is not 
visible in the profile of this backup user (i.e. The [User Profile] page still reports no files in the data 
area). You need to run the Rebuild User Storage job by setting the scheduled run time of this 
routine job to a more recent time to rebuild the user storage information for this user. 

If you need to perform another import (seed loading) when there are backup files on the backup server already, 
please remove all existing backup files from the backup server by removing the backup set ID directory (i.e. a 
numerically named directory under the “files” directory under a user directory) before copying all new seed 
loading files into the system. If you have more than one backup set ID directory under the “files” directory, 
please take a look at [User Home Directory] \ db \ Profile.xml to find out the correct backup set ID for the 
required backup set. 
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12.2 Saving backup files to off-line media (Export) 
If you want to save a copy of all backup files under a backup user account to an offline media, please do the 
following:  

i. Locate the home directory of the backup user 
 
A backup user’s home directory is a directory named the login name of the backup user under one 
of the OBS’s [User Homes] directories. [User Homes] is a system-wide setting which can be 
accessed under the [Manage System] menu after logging onto the web system management 
console. 
 
For example: 
 
The default [Users Homes] directory is “C:\Program Files\Ahsay Offsite Backup Server\user”. If the 
login name of the backup account is “john”, the home directory of user “john” should be 
“C:\Program Files\Ahsay Offsite Backup Server\user\john” 

ii. Copy the complete home directory of this backup user to an offline media 

iii. Once the offline media is shipped to the user, the user can then use the [Decrypt File Wizard] 
available in OBM to decrypt and restore the backup files available in the offline backup back to its 
original format 
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13 Secure Socket Layer (SSL) Configuration 
This chapter describes how you can use the Management Console to configure various settings of OBS. 

13.1 Installing a trusted SSL certificate 
Default installation of OBS enables SSL (Secure Socket Layer) support using a dummy certificate. For your own 
security, you are advised to replace the pre-installed dummy SSL certificate with a secure SSL certificate from a 
trusted CA (Certificate Authority). To replace the non-secure dummy SSL certificate with a secure SSL certificate, 
please do the following: 

i. Identify the location of the keystore file 
 
You need to store your SSL certificate in a keystore file. The default location of the keystore file is 
%INSTALL_DIR%\conf\keystore. 

ii. Delete dummy certificate from keystore 
 
You can delete the dummy SSL certificate from the keystore by running:  
 
%INSTALL_DIR%\java\bin\keytool -delete -alias tomcat -keystore %INSTALL_DIR%\conf\keystore 

You will be prompted for the keystore password. The default password is “changeit”. 

Platform Example 
Windows C:\Program Files\Ahsay Offsite Backup Server\conf> “C:\Program Files\Ahsay Offsite Backup 

Server\java\bin\”keytool -delete -alias tomcat -keystore keystore 

Linux [root]# $OBS_HOME/java/bin/keytool -delete -alias tomcat -keystore $OBM_HOME/conf/keystore 

Mac OS X [root]# keytool -delete -alias tomcat -keystore /Applications/OBS/conf/keystore 

iii. Generate RSA key pair 
 
A SSL certificate contains a RSA key pair. You can generate a RSA key pair by running: 
 
%INSTALL_DIR%\java\bin\keytool -genkey -alias tomcat -keyalg RSA -keysize 1024 
-keystore %INSTALL_DIR%\conf\keystore 
 
Also, the key password for the alias “tomcat” must be the same as the keystore password. Please 
simply press the [Enter] key when you are prompted for the key password for tomcat (i.e. press 
[Enter] when you see the “key password for <tomcat>” prompt) 

Platform Example 
Windows C:\Program Files\Ahsay Offsite Backup Server\conf> “C:\Program Files\Ahsay Offsite Backup 

Server\java\bin\”keytool -genkey -alias tomcat -keyalg RSA -keystore keystore 

Linux [root]# $OBS_HOME/java/bin/keytool -genkey -alias tomcat -keyalg RSA -keystore 
$OBM_HOME/conf/keystore 

Mac OS X [root]# keytool -genkey -alias tomcat -keyalg RSA -keystore /Applications/OBS/conf/keystore 

iv. Create a local Certificate Signing Request (CSR)  
 
You can create a CSR for your SSL certificate by running: 
 
%INSTALL_DIR%\java\bin\keytool -certreq -keyalg RSA -alias tomcat  
-file ssl.csr -keystore %INSTALL_DIR%\conf\keystore 
 

Platform Example 
Windows C:\Program Files\Ahsay Offsite Backup Server\conf> “C:\Program Files\Ahsay Offsite Backup 

Server\java\bin\”keytool -certreq -keyalg RSA -alias tomcat -keystore keystore 

Linux [root]# $OBS_HOME/java/bin/keytool -certreq -keyalg RSA -alias tomcat -keystore 
$OBM_HOME/conf/keystore 

Mac OS X [root]# keytool -certreq -keyalg RSA -alias tomcat -keystore /Applications/OBS/conf/keystore 

v. Submit the CSR file to a trusted CA of your choice 
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vi. Import signed SSL certificate from CA back to the keystore from which the CSR was generated by: 
 
%INSTALL_DIR%\java\bin\keytool -import -alias tomcat -trustcacerts -file ssl.crt  
-keystore %INSTALL_DIR%\conf\keystore 
 

Platform Example 
Windows C:\Program Files\Ahsay Offsite Backup Server\conf> “C:\Program Files\Ahsay Offsite Backup 

Server\java\bin\”keytool -import -alias tomcat –trustcacerts –file ssl.crt -keystore keystore 

Linux [root]# $OBS_HOME/java/bin/keytool -import -alias tomcat –trustcacerts –file ssl.crt -keystore 
$OBM_HOME/conf/keystore 

Mac OS X [root]# keytool -import -alias tomcat –trustcacerts –file ssl.crt -keystore 
/Applications/OBS/conf/keystore 

If you are getting the "keytool error: java.lang.Exception: Failed to establish chain from reply"
message when importing the SSL certificate file from CA, please try double-clicking the ssl.crt file 
on Windows to view all intermediate certificates being used to sign your certificate and import all 
intermediate certificates (downloadable from your CA) into your keystore file before importing your 
SSL certificate. 

vii. Check if you have installed the SSL certificate correctly by: 
 
%INSTALL_DIR%\java\bin\keytool -list -alias tomcat -keystore %INSTALL_DIR%\conf\keystore 
 

Platform Example 
Windows C:\Program Files\Ahsay Offsite Backup Server\conf>”C:\Program Files\Ahsay Offsite Backup 

Server\java\bin\”keytool -list -alias tomcat -keystore keystore 
Linux [root]# $OBS_HOME/java/bin/keytool -list -alias tomcat -keystore $OBM_HOME/conf/keystore 
Mac OS X [root]# keytool -list -alias tomcat -keystore /Applications/OBS/conf/keystore 

tomcat, 2003/6/13, keyEntry,
Certificate fingerprint (MD5): xx:xx:xx:xx:xx:xx:xx:xx:xx:xx:xx:xx:xx:xx:xx:xx 

Please make sure that you are getting the type “keyEntry” instead of “trustedCertEntry” from the 
output above. If you are getting “trustedCertEntry”, the most likely cause of this is that you are 
NOT importing the SSL certificate back into the same keystore from which the CSR was generated. 
The only solution to this is to find this keystore file and import the certificate(s) to the keystore file 
again. If you can’t find this file, please repeat the instructions in this section from step (i) and try 
again. 

* When asked for your “first and last name” during the key generation, please specify the domain 
that you will be using this certificate for. Please refer to the following example. 

Full Example 
C:\Program Files\Ahsay Offsite Backup Server\conf> “C:\Program Files\Ahsay Offsite Backup Server\java\bin\”keytool -
delete -alias tomcat -keystore keystore 

C:\Program Files\Ahsay Offsite Backup Server\conf> “C:\Program Files\Ahsay Offsite Backup Server\java\bin\”keytool -
genkey -alias tomcat -keyalg RSA -keystore keystore 
 
Enter keystore password:  changeit 
What is your first and last name? 
 [Unknown]:  www.secure-company.com 
What is the name of your organizational unit? 
 [Unknown]:  NOT SECURE 
What is the name of your organization? 
 [Unknown]:  NOT SECURE 
What is the name of your City or Locality? 
 [Unknown]:  NOT SECURE 
What is the name of your State or Province? 
 [Unknown]:  NOT SECURE 
What is the two-letter country code for this unit? 
 [Unknown]:  NS 
Is <CN=www.secure-company.com, OU=NOT SECURE, O=NOT SECURE, L=NOT SECURE, ST=NOT SECURE, C=NS> correct? 
 [no]:  yes 
 
Enter key password for <tomcat> 
 (RETURN if same as keystore password): 
 
C:\Program Files\Ahsay Offsite Backup Server\conf> “C:\Program Files\Ahsay Offsite Backup Server\java\bin\”keytool –
certreq -keyalg RSA –alias tomcat -file certreq.csr -keystore keystore 
Enter keystore password:  changeit 
 
C:\Program Files\Ahsay Offsite Backup Server\conf > “C:\Program Files\Ahsay Offsite Backup Server\java\bin\”keytool –
import -alias tomcat -keystore keystore -trustcacerts -file ssl.crt 
Enter keystore password:  changeit 
Certificate reply was installed in keystore 
 

C:\Program Files\Ahsay Offsite Backup Server\conf > “C:\Program Files\Ahsay Offsite Backup Server\java\bin\”keytool –list
-alias tomcat -keystore keystore  
 
tomcat, 2003/6/13, keyEntry, 
Certificate fingerprint (MD5): xx:xx:xx:xx:xx:xx:xx:xx:xx:xx:xx:xx:xx:xx:xx:xx 
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13.2 Enforcing SSL to the web interface 
If you want all users to connect to the web interface of OBS using SSL to enforce secure connection, please do 
the followings: 

i. Open %INSTALL_DIR%\webapps\obs\WEB-INF\web.xml 

ii. Locate the [Enforce SSL] section at the end of “web.xml”  

web.xml 
…. 
<!-- ================================================================================= --> 

 <!-- ================================ Enforce SSL ==================================== --> 
 <!-- == Please uncomment the following section to enforce SSL for the web interface == --> 
 <!-- ================================================================================= --> 
<!--  
 <security-constraint>  
 <web-resource-collection>  
 <web-resource-name>Automatic SLL Forwarding</web-resource-name>  
 <url-pattern>/jsp/user/*</url-pattern>  
 <url-pattern>/jsp/system/*</url-pattern>  
 </web-resource-collection>  
 <user-data-constraint>  
 <transport-guarantee>CONFIDENTIAL</transport-guarantee>  
 </user-data-constraint>  
 </security-constraint> 
--> 
…. 

iii. Remove the XML comment tags (“<!--” and “-->”, shown in red and bold above) from “web.xml” 

iv. Restart OBS 

Please note that this only enforces SSL when users log onto the web interface of OBS. It doesn’t enforce backup 
traffic from OBM to be SSL. 
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14 Monitoring System Activities 
This chapter describes how you can use the [Manage Log] -> [System Log] page (shown below) to review system 
and backup activities of OBS. 

14.1 Reviewing System Log 
When you click the [Manage Log] -> [System Log] link available at the top menu, the [System Log] panel will 
appear. It lists all system messages / warnings / errors logged within the date shown on the drop down list. You 
can review the system messages / warnings / errors logged on any particular date by selecting the required date 
from the drop down list. 
 

Key Description 
Date The date when all messages were logged  
Rows/Page The number of rows to display per page 
Timestamp The time when the message was logged 
Message The system log message 

14.2 Reviewing Backup Log 
When you click the [Manage Log] -> [Backup Log] link available at the top menu, the [Backup Log] panel will 
appear. It lists all backup jobs run on a particular date. You can review the backup jobs run on any particular 
date by selecting the required date from the drop down list. 
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Key Description 
Date The date when all backup jobs listed below were run 
Backup Period Start and end time of this backup job 
Login Name Backup Account that ran this backup job 
Job No. Backup Job Number 
Upload Size Size of backup data uploaded 
Status Overall status of the backup job 

14.3 Reviewing Restored File Log 
When you click the [Manage Log] -> [Restored File] link available at the top menu, the [Restore Log] panel will 
appear. It lists all online file restoration activities logged within a date. You can review online file restoration 
activities recorded on any particular date by selecting the required date from the drop down list. 
 

Key Description 
Date The date when all online file restoration were recorded 
Timestamp Start and end time of the file restoration activities 
Login Name Backup account restoring files from the server 
Size Total backup data restored from the server 
IP IP address to where backup data were restored 
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14.4 Reviewing Backup Error Log 
When you click the [Manage Log] -> [Backup Error] link available at the top menu, the [Backup Error] panel will 
appear. It lists all backup errors or warning logged within a date. You can review backup errors or warnings 
logged on any particular date by selecting the required date from the drop down list. 
 

Key Description 
Date The date when all messages were logged 
Timestamp The time when this message was logged 
Login Name Backup account raising this error or warning 
Errors / Warnings Details of the error or warning recorded 

14.5 Reviewing Advertisement Log 
When you click the [Manage Log] -> [Advertisement Log] link available at the top menu, the [Advertisement 
Log] panel will appear. It lists all the advertisements displayed by ACB clients for a particular date. You can 
review displayed adverts on any particular date by selecting the required date from the drop down list. 
 

Key Description 
Date The date when the advertisements listed below were displayed 
Rows/Page The number of rows to display per page 
Timestamp The time when the advert was displayed 
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Name The name of the advertisement 
Type Advertisement display types: 

� IMP – Impression, this advertisement was displayed 
� HIT – Hit, this advertisement was displayed and the user clicked the advert to go to 

the target web page. 
User Name The user account name of the ACB client 
Remote IP The remote IP address of the ACB client 
URL The target URL associated with this advert 

14.6 Reviewing access logs 
If you are interested in reviewing how your clients are accessing OBS, you can take a look at the access logs files 
available in %INSTALL_DIR%\logs\access_log.YYYY-MM-DD.txt 
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15 Branding OBM (Partners Only)  

15.1 Customization Portal 
The OBM customization portal (http://partners.ahsay.com/) allows you to do the followings: 

i. Building an OBM installer (e.g. obm-win.exe for Windows) under your own company name 

ii. Set the vendor name, support email and URL to your own values 

iii. Put your own company logo and other images into OBM 

iv. Set the default backup server hostname, TCP port number and protocol (HTTP/HTTPS) to your own 
values 

v. Hide/Show encrypting key checkbox in OBM 

vi. Hide/Show language selection list in OBM 

vii. Hide/Show the backup server URL textbox in OBM 

viii. Set the default language for OBM 

ix. Enable/Disable languages for OBM 

x. Enable/Disable user account profile update from OBM 

xi. Customize the terms of use statements shown in the installer of OBM  

Once you have made all the customization you want, you can download a customized version of OBM from the 
download page (shown below) of the customization portal. 

Please refer to the Installers Customization Guide from the OBM customization portal for more information. 

 

http://partners.ahsay.com/
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16 Branding OBS 
This chapter describes how you can customize OBS to make it look the way you want it to be. 

16.1 Welcome page 
If you would like to use your own welcome page on the backup server, simply replace the default welcome page, 
%INSTALL_DIR%\webapps\ROOT\index.html, with your own welcome page. 

16.2 Different welcome pages for different domains 
If you want to show different welcome pages for requests to different domain names, please do the followings: 

i. Rename %INSTALL_DIR%\webapps\ROOT\index.html to 
%INSTALL_DIR%\webapps\ROOT\index_defaultDomain.html  

ii. Create %INSTALL_DIR%\webapps\ROOT\index.jsp with the following content. Suppose you have 4 
domains in total. If you want requests to OBS using the domain name “domain2.com” to see 
“index_Domain2.html”and requests to OBS using the domain name “domain3.com” to see 
“index_Domain3.html”, you should put the highlighted code below. 
 

%INSTALL_DIR%\webapps\ROOT\index.jsp 
<%@ page language="java" %> 
<%--  
 
If you want to redirect request from different domains to different  

 index pages, please modify the "domain to URL mapping" defined by the 
 String array declaration below to define your own mapping. 
 
--%> 
<%  
String sURL = "index_defaultDomain.html"; 
 String sRequestURL = request.getRequestURL().toString().toLowerCase();  
 String[] asMap = {  
 "domain2.com", "index_Domain2.html",  
 "domain3.com", "index_Domain3.html",  
 }; 
 for(int i=0; asMap!=null && i<asMap.length; i+=2) { 
 String sDomain = asMap[i].toLowerCase(); 
 if(sRequestURL.indexOf(sDomain)!=-1) { 
 sURL=asMap[i+1]; 
 break; 
 }

}
response.sendRedirect(sURL); 
%> 

Please note that you need to create the both “index_Domain2.html” and “index_Domain3.html” 
yourself and place it in the %INSTALL_DIR%\webapps\ROOT directory. 

16.3 Customizing the company logo displayed 
Two different logos are displayed on the bottom left hand corner and bottom right hand corner of every page. 



We back up your business 
Ahsay Offsite Backup Server v5.2

Administrator’s Guide

Ahsay Systems Corporation Limited Page 53 of 85 (April 15, 2008)

You can customize the logos shown on the bottom left hand corner and the bottom right hand corner of every 
page by: 

i. Go to %INSTALL_DIR%\webapps\obs\logo 

ii. To display your image at the bottom left hand corner of every page, simply save your image as 
“default.small.left.gif” in the directory above 

iii. To display your image at the bottom left hand corner of every page, simply save your image as 
“default.small.right.gif” in the directory above 

iv. If you don’t want to display any images at these locations, just rename “empty.gif” to 
“default.small.left.gif” or “default.small.right.gif” 

Different logos for different domain names

If you are mapping both domain “www.company-A.com” and domain “www.company-B.com” to the IP address of 
the OBS and you want to display different logos when users are browsing the web pages using different domain 
names, you can do the followings: 

i. Go to %INSTALL_DIR%\webapps\obs\logo 

ii. To display your image at the bottom left and right hand corner of every page for domain 
“www.company-A.com”, simply save your image as “www.company-A.com.small.left.gif” and 
“www.company-A.com.small.right.gif” respectively in the directory above 

iii. To display your image at the bottom left and right hand corner of every page for domain 
“www.company-B.com”, simply save your image as “www.company-B.com.small.left.gif” and 
“www.company-B.com.small.right.gif” respectively in the directory above 

16.4 Customizing the Look and Feel of the web interface 
The Look and Feel (e.g. font size and color) of the web interface of OBS is defined by a set of rules defined in a 
cascade style sheet. If you want to customize the Look and Feel of the web interface to fully integrate OBS into 
your website, you can do the followings: 

i. Open %INSTALL_DIR%\webapps\obs\jsp\lib\jsp_*.css (e.g. en=English, fr=French, cs=Czech, 
da=Danish, nl=Dutch, de=German, es=Spanish, sv=Swedish, zh_TW=Traditional_Chinese, 
zh_CN=Simplified_Chinese etc) 

ii. Make the changes to the cascade style sheet file to what you would like to see.  
 
For example, if you want to change the English user menu bar from yellowish color (#FFCC00) to 

http://www.company-a.com/
http://www.company-a.com/
http://www.company-b.com/
http://www.company-a.com/
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red color. Please do the followings: 

Extract of jsp_en.css (Original) 
…. 
/* menu bar - background color; text color, weight */ 
.usermenu_menubar { 
 background-color: #FFCC00;

color: #000000 
 font-weight: normal 
}
…. 

Extract of jsp_en.css (updated) 
…. 
/* menu bar - background color; text color, weight */ 
.usermenu_menubar { 
 background-color: red;

color: #000000 
 font-weight: normal 
}
…. 

iii. Restart your browser to see the changes 

16.5 Customizing all text of the web interface 
All text displayed on the web interface of OBS are stored in properties files. If you want to modify any of the text 
information displayed on the web interface, please do the followings: 

i. Open %INSTALL_DIR%\properties.xls located on OBS (There are VBA scripts inside this Excel file. 
Please use Excel 2000 or above to open this file) 

ii. Switch to the [obs-jsp] worksheet 

iii. Modify the entries that you want to customize 

iv. Press the [Generate] button 

v. Copy the generated jsp_*.properties files, which can be found under the [obs] subdirectory under 
the directory where the Excel file is located, to %INSTALL_DIR%\webapps\obs\WEB-INF\classes 

vi. Restart OBS backup services to see the changes 

16.6 Customizing email reports 
The instruction of customizing all text in all outgoing email reports is the same as the instruction of customizing 
all text displayed on the web interface. Simply do this: 

i. Open %INSTALL_DIR%\properties.xls located on OBS (There are VBA scripts inside this Excel file. 
Please use Excel 2000 or above to open this file) 

ii. Switch to the [obs-jsp] worksheet 

iii. Modify the [jsp.report.*] entries that you want to customize 

iv. Press the [Generate] button 

v. Copy the generated [ obs \ jsp_*.properties] files to %INSTALL_DIR%\webapps\obs\WEB-
INF\classes 

vi. Restart OBS backup services to see the changes 

If you are interested in displaying your own logo in all out-going email reports, simply replace 
%INSTALL_DIR%\webapps\obs\logo\default.large.gif with your own logo. All email reports sent after you have 
made the changes will carry your customized logo. 

It is currently not possible to change the layout and the Look&Feel (e.g. color, font size) of all out-going email 
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reports. This feature will be available in v6.0 scheduled late 2006. 

16.7 Localizing the software 
It is currently possible to have OBS localized to another language without the assistance of our development 
team. If you would like to have OBS available in languages other than those currently supported, please feel free 
to contact us to discuss possible arrangement. 
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17 Other Configuration 
The default installation of OBS setup a typical environment to run your backup server but it is still possible that 
the default setting does not fit well into your environment. The chapter describes all supported customizations 
you can do to the software to fulfil your special needs.  

17.1 Listening to non-standard TCP/IP Port 
If you like to run your own web server, or some other services using port 80 and 433, on your backup server, 
you can change the listening TCP/IP port of OBS from port 80 and 443 to some other port numbers by: 

i. Open %INSTALL_DIR%\conf\server.xml 

Server.xml  
<Server port="8014" shutdown="SHUTDOWN" debug="0"> 
 
<Service name="Tomcat-Standalone"> 

 
<!-- Define a non-SSL HTTP/1.1 Connector on port 80 --> 

 <Connector className="org.apache.coyote.tomcat5.CoyoteConnector" 
 address="0.0.0.0" port="80" maxHttpHeaderSize="8192" maxKeepAliveRequests="1" 
 maxThreads="1000" minSpareThreads="25" maxSpareThreads="100" 
 enableLookups="false" redirectPort="443" bufferSize="32768" acceptCount="1000" 
 connectionTimeout="600000" disableUploadTimeout="true"/> 
 

<!-- Define a SSL HTTP/1.1 Connector on port 443 --> 
 <Connector className="org.apache.coyote.tomcat5.CoyoteConnector" 
 address="0.0.0.0" port="443" maxHttpHeaderSize="8192" maxKeepAliveRequests="1" 
 maxThreads="1000" minSpareThreads="25" maxSpareThreads="100" 
 enableLookups="false" disableUploadTimeout="true" 
 acceptCount="1000" bufferSize="32768" scheme="https" secure="true" 
 keystoreFile="conf/keystore" keystorePass="changeit" 
 clientAuth="false" sslProtocol="TLS" connectionTimeout="600000"/> 
... 

ii. Change the [port] values (shown in red and bold above) to the preferred port numbers. For 
example, to change the HTTP port from port 80 to 8080 and HTTPS port from port 443 to port 
8443, please do the followings: 
 

port=”80” -> port=”8080 
 redirectPort=”443” -> redirectPort =”8443”  
 port=”443” -> port=”8443” 

iii. Restart OBS 

iv. Logon to the System Management Console 

v. Append the custom TCP/IP port number to the [Host Name] setting  
 
For example: backup.your-company.com:8080 
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17.2 Listening to a single IP address 
If the backup server has more than one network interface installed or has more than one IP address bind to a 
single network interface, you can configure OBS to use only a single IP address for backup services (by default 
the TCP port of all IP addresses available within the system are used and open). This has the benefits of sparing 
other IP addresses for other applications, e.g. Apache Web Server or Microsoft Internet Information Server (IIS). 
To do so,  

i. Open %INSTALL_DIR%\conf\server.xml 

Server.xml  
<Server port="8014" shutdown="SHUTDOWN" debug="0"> 
 
<Service name="Tomcat-Standalone"> 

 
<!-- Define a non-SSL HTTP/1.1 Connector on port 80 --> 

 <Connector className="org.apache.coyote.tomcat5.CoyoteConnector" 
 address="0.0.0.0" port="80" maxHttpHeaderSize="8192" maxKeepAliveRequests="1" 
 maxThreads="1000" minSpareThreads="25" maxSpareThreads="100" 
 enableLookups="false" redirectPort="443" bufferSize="32768" acceptCount="1000" 
 connectionTimeout="600000" disableUploadTimeout="true"/> 
 

<!-- Define a SSL HTTP/1.1 Connector on port 443 --> 
 <Connector className="org.apache.coyote.tomcat5.CoyoteConnector" 
 address="0.0.0.0" port="443" maxHttpHeaderSize="8192" maxKeepAliveRequests="1" 
 maxThreads="1000" minSpareThreads="25" maxSpareThreads="100" 
 enableLookups="false" disableUploadTimeout="true" 
 acceptCount="1000" bufferSize="32768" scheme="https" secure="true" 
 keystoreFile="conf/keystore" keystorePass="changeit" 
 clientAuth="false" sslProtocol="TLS" connectionTimeout="600000"/> 
... 

ii. Change the [address] values (shown in red and bold above) to the IP address that are to be used 
for OBS. For example, to use only the IP address, 192.168.1.1, for backup service, change the 
address values from “0.0.0.0” (means all available IP addresses) to “192.168.1.1”  
 

address="0.0.0.0" -> address="192.168.1.1” 

iii. Restart OBS 

If you are going to use IIS along with OBS on different IP addresses as mentioned here, please make sure that 
you have configured IIS to spare the IP address configured above to be used by OBS (by default IIS will use the 
all IP addresses available). Failing to do so will result in failing to start both IIS and OBS at the same time. 
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This chapter describes all other features available in the software. 

17.3 Backing up OBS  
All system settings you have made on the web pages behind the [Backup System Administration Logon] link are 
saved in %INSTALL_DIR%\config\obs.xml. You just need to backup this file to backup all the settings.  

Of course, all files under the [User Homes] directories and [System Home] directory are to be backed up unless 
you can afford to lose your users’ backup data and all system information logged by OBS. 

17.4 Restricting access to system page by IP address 
For better security, you can restrict access to the system administration console by IP addresses. To do so, 
please do the followings: 

i. Open %INSTALL_DIR%\webapps\obs\WEB-INF\web.xml 

ii. Locate the [filter] section near the beginning of “web.xml” 

web.xml 
…. 
<filter> 

 <filter-name>SystemConsole</filter-name> 
 <filter-class>com.ahsay.obs.www.IPFilter</filter-class> 
 <init-param> 
 <param-name>Range1</param-name> 
 <param-value>localhost</param-value> 
 </init-param> 
 <init-param> 
 <param-name>Range2</param-name> 
 <param-value>0.0.0.0-255.255.255.255</param-value> 
 </init-param> 
 </filter> 
…. 

iii. Change the [Range2] parameter value from “127.0.0.1-127.0.0.1” (shown in red and bold above) 
to a range of IP addresses from where access to the system administration console is allowed.  
 
For example, changing [Range2] value from ” 127.0.0.1-127.0.0.1” to “192.168.1.1-
192.168.1.255” to allow the 192.168.1.x network to invoke the APIs. 

web.xml (Updated) 
…. 
<filter> 

 <filter-name>SystemConsole</filter-name> 
 <filter-class>com.ahsay.obs.www.IPFilter</filter-class> 
 <init-param> 
 <param-name>Range1</param-name> 
 <param-value>localhost</param-value> 
 </init-param> 
 <init-param> 
 <param-name>Range2</param-name> 
 <param-value>192.168.1.1-192.168.1.255</param-value> 
 </init-param> 
 </filter> 
…. 

Please note that you can configure more than one IP range by adding additional init parameters (i.e. 
“Range3”, “Range4” and so do) to the filter XML tag. 
 
For example,  
 
<filter> 

 <filter-name>SystemConsole</filter-name> 
 <filter-class>com.ahsay.obs.www.IPFilter</filter-class> 
 <init-param> 
 <param-name>Range1</param-name> 
 <param-value>localhost</param-value> 
 </init-param> 
 <init-param> 
 <param-name>Range2</param-name> 
 <param-value>192.168.1.1-192.168.1.255</param-value> 
 </init-param> 
 <init-param> 
 <param-name>Range3</param-name> 
 <param-value>192.168.2.1-192.168.2.255</param-value> 
 </init-param> 
 </filter> 

iv. Restart OBS 
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18 External APIs 
OBS contains a set of APIs (Application Programming Interface), which allows you to integrate external 
applications (e.g. billing system or automated registration system) with OBS. This chapter describes what APIs 
are available and how you can invoke different APIs. 

You can find more information on processing XML using Java at http://java.sun.com/xml/.

18.1 Overview 
OBS APIs can be invoked by using standard HTTP request method (i.e. either POST or GET). For example, to 
invoke the [Remove User] API, simply use any programming/scripting languages of your choice to invoke  
“http://BACKUP_SERVER/obs/api/RemoveUser.do?SysUser=system&SysPwd=system&LoginName=test” to delete 
user “test”. 

URL encoding must be applied to all non-alphanumeric parameters when submitting the API requests as 
specified in the HTTP protocol specification. For example, a value of "GMT-08:00 (PST)" must be submitted to 
OBS in external API as “GMT%2d08%3a00+%28PST%29”. 

18.2 IP Restrictions 
To avoid OBS’s APIs from being exploited by hackers from an unauthorized network, OBS, by default, accepts 
and handles only the API requests originating from the same local machine. To loosen this restriction, please do 
the followings: 

i. Open %INSTALL_DIR%\webapps\obs\WEB-INF\web.xml 

ii. Locate the [filter] section near the beginning of “web.xml” 

web.xml 
…. 
<filter> 

 <filter-name>LocalhostOnly</filter-name> 
 <filter-class>com.ahsay.obs.www.IPFilter</filter-class> 
 <init-param> 
 <param-name>Range1</param-name> 
 <param-value>localhost</param-value> 
 </init-param> 
 <init-param> 
 <param-name>Range2</param-name> 
 <param-value>127.0.0.1-127.0.0.1</param-value> 
 </init-param> 
 </filter> 
…. 

iii. Change the [Range1] parameter value from “127.0.0.1-127.0.0.1” (shown in red and bold above) 
to another range of IP addresses from where APIs can be invoked.  
 
For example, changing [Range1] value from ” 127.0.0.1-127.0.0.1” to “192.168.1.1-
192.168.1.255” to allow the 192.168.1.x network to invoke the APIs. 

web.xml (Updated) 
…. 
<filter> 

 <filter-name>LocalhostOnly</filter-name> 
 <filter-class>com.ahsay.obs.www.IPFilter</filter-class> 
 <init-param> 
 <param-name>Range1</param-name> 
 <param-value>localhost</param-value> 
 </init-param> 
 <init-param> 
 <param-name>Range2</param-name> 
 <param-value>192.168.1.1-192.168.1.255</param-value> 
 </init-param> 
 </filter> 
…. 

Please note that you can configure more than two IP ranges by adding additional init parameters 
(i.e. “Range3”, “Range4” and so do) to the filter XML tag. 
 
For example,  
 
<filter> 

 <filter-name>LocalhostOnly</filter-name> 
 <filter-class>com.ahsay.obs.www.IPFilter</filter-class> 

http://java.sun.com/xml/
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<init-param> 
 <param-name>Range1</param-name> 
 <param-value>localhost</param-value> 
 </init-param> 
 <init-param> 
 <param-name>Range2</param-name> 
 <param-value>192.168.1.1-192.168.1.255</param-value> 
 </init-param> 

<init-param> 
 <param-name>Range3</param-name> 
 <param-value>192.168.2.1-192.168.2.255</param-value> 
 </init-param> 
 </filter> 

iv. Restart OBS 

18.3 User Authorization 
The following table describes all information required to invoke the [Auth User] API to check whether an existing 
user is authorized. 

URL: 
http://BACKUP_SERVER/obs/api/AuthUser.do

Parameters: 
Key Value Descriptions 

SysUser String OBS’s System Username 

SysPwd String OBS’s System password 

LoginName String Login name of the user 

Password String Password of the user 

Return Value: 
If successful, returns <OK/> 
If there is an error, returns <err>%ERROR_MESSAGE%</err> 

Example: 
http://BACKUP_SERVER/obs/api/AuthUser.do?SysUser=system&SysPwd=system&LoginName=test&Password=abc

18.4 Adding User 
The following table describes all information required to invoke the [Add User] API to add a new user to OBS. 

URL: 
http://BACKUP_SERVER/obs/api/AddUser.do

Parameters: 
Key Value Descriptions 

SysUser String OBS’s System Username 

SysPwd String OBS’s System password 

LoginName String New user’s login name 

Password String New user’s password 

Alias String New user’s alias 

Language String New user’s language, e.g. [ en | cs | da | de | es | fr | fi | is | it | ja | lt | nl | no | pt_PT | sl | sv | zh_TW 
| zh_CN ] 
where 
“en” = English, “cs” = Czech, “da” = Danish, “de” = German, “es” = Spanish, “fr” =French, “fi” = 
Finnish, “is” = Icelandic, “it” =Italian, “ja” = Japanese, “lt” = Lithuanian, “nl” = Dutch, 
“no”=Norwegian, “pt_PT” = Portuguese, “sl” = Slovenian, “sv” = Swedish, “zh_CN” = Chinese 
(Simplified), “zh_TW” = Chinese (Traditional) 

Type String New user’s type, e.g. [ TRIAL | PAID ] 

ClientType String New user’s client type, e.g. [ OBM | ACB ] 

AdGroup String Advertisement group (ACB clients only) e.g. [ ALL | NONE ] 

Quota Number New user’s quota, e.g. 104857600 (for 100MB) 

UserHome String User Home to use for the new user (must be one of the configured user home), e.g. C:\Program 
Files\Ahsay Offsite Backup Server\user 

EnableMSSQL Boolean Whether to enable Microsoft SQL Server module for the new user, e.g. [ Y | N ] 

EnableMSExchange Boolean Whether to enable Microsoft Exchange Server module for the new user, e.g. [ Y | N ] 

EnableOracle Boolean Whether to enable Oracle module for the new user, e.g. [ Y | N ] 

EnableLotusNotes Boolean Whether to enable Lotus Notes module for the new user, e.g. [ Y | N ] 

EnableLotusDomino Boolean Whether to enable Lotus Domino module for the new user, e.g. [ Y | N ] 

http://backup_server/obs/api/AddUser.do
http://backup_server/obs/api/AuthUser.do?SysUser=system&SysPwd=system&LoginName=test&Password=abc
http://backup_server/obs/api/AuthUser.do
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EnableMySQL Boolean Whether to enable MySQL module for the new user, e.g. [ Y | N ] 

EnableInFileDelta Boolean Whether to enable In-File Delta module for the new user, e.g. [ Y | N ] 

EnableShadowCopy Boolean Whether to enable Shadow Copy module for the new user, e.g. [ Y | N ] 

EnableExchangeMailbox Boolean Whether to enable Brick Level Microsoft Exchange module for the new user, e.g. [ Y | N ] 

ExchangeMailboxQuota Number The number of Microsoft Exchange mailboxes allowed for the user. 

Contact[1-9] String Extra contact name. Notes, There can be more than one extra name added, extra contact name 
must be in pair with extra email 

Email[1-9] String Extra contact e-mail. Notes, There can be more than one extra email added, extra contact email 
must be in pair with extra contact name 
New User’s time zone setting. It has to be either one of the following entries:  
Please make sure the parameter is properly URL encoded. E.g. GMT-08:00 (PST) => 
GMT%2d08%3a00+%28PST%29 

Timezone String 

GMT-11:00 (WST) 
GMT-11:00 (NUT) 
GMT-11:00 (SST) 
GMT-10:00 (HADT) 
GMT-10:00 (HST) 
GMT-10:00 (TKT) 
GMT-10:00 (HST) 
GMT-10:00 (CKT) 
GMT-10:00 (TAHT) 
GMT-09:00 (AKDT) 
GMT-09:00 (GAMT) 
GMT-08:00 (PST) 
GMT-08:00 (PDT) 
GMT-07:00 (MST) 
GMT-07:00 (MDT) 
GMT-06:00 (CST) 
GMT-06:00 (CDT) 
GMT-06:00 (EAST) 
GMT-06:00 (GALT) 
GMT-05:00 (EST) 
GMT-05:00 (EDT) 
GMT-05:00 (COT) 
GMT-05:00 (ECT) 
GMT-05:00 (CDT) 
GMT-05:00 (PET) 
GMT-05:00 (ACT) 
GMT-05:00 (GMT-
05:00) 
GMT-04:00 (AST) 
GMT-04:00 (PYT) 
GMT-04:00 (VET) 
GMT-04:00 (AMT) 
GMT-04:00 (GYT) 
GMT-04:00 (ADT) 
GMT-04:00 (BOT) 

GMT-04:00 (AMT) 
GMT-04:00 (CLT) 
GMT-04:00 (FKT) 
GMT-03:00 (ART) 
GMT-03:00 (GFT) 
GMT-03:00 (BRT) 
GMT-03:00 (WGST) 
GMT-03:00 (PMDT) 
GMT-03:00 (UYT) 
GMT-03:00 (SRT) 
GMT-02:00 (FNT) 
GMT-02:00 (GST) 
GMT-01:00 (EGST) 
GMT-01:00 (AZOST) 
GMT-01:00 (CVT) 
GMT-01:00 (EGT) 
GMT+00:00 (GMT) 
GMT+00:00 (WET) 
GMT+00:00 (WEST) 
GMT+00:00 (IST) 
GMT+00:00 (BST) 
GMT+00:00 (UTC) 
GMT+01:00 (CET) 
GMT+01:00 (WAT) 
GMT+01:00 (CEST) 
GMT+02:00 (EEST) 
GMT+02:00 (CAT) 
GMT+02:00 (SAST) 
GMT+02:00 (EET) 
GMT+02:00 (IDT) 
GMT+03:00 (EAT) 
GMT+03:00 (AST) 
GMT+03:00 (ADT) 

GMT+03:00 (MSD) 
GMT+04:00 (AQTST) 
GMT+04:00 (AZST) 
GMT+04:00 (GST) 
GMT+04:00 (GEST) 
GMT+04:00 (AMST) 
GMT+04:00 (SAMST) 
GMT+04:00 (SCT) 
GMT+04:00 (MUT) 
GMT+04:00 (RET) 
GMT+05:00 (TMT) 
GMT+05:00 (KGST) 
GMT+05:00 (TJT) 
GMT+05:00 (PKT) 
GMT+05:00 (UZT) 
GMT+05:00 (YEKST) 
GMT+05:00 (IOT) 
GMT+05:00 (TFT) 
GMT+05:00 (MVT) 
GMT+06:00 (MAWT) 
GMT+06:00 (ALMST) 
GMT+06:00 (LKT) 
GMT+06:00 (BDT) 
GMT+06:00 (NOVST) 
GMT+06:00 (BTT) 
GMT+07:00 (ICT) 
GMT+07:00 (JAVT) 
GMT+07:00 (KRAST) 
GMT+07:00 (CXT) 
GMT+08:00 (HKT) 
GMT+08:00 (CST) 
GMT+08:00 (BNT) 
GMT+08:00 (WST) 

GMT+08:00 (IRKST) 
GMT+08:00 (MYT) 
GMT+08:00 (PHT) 
GMT+08:00 (SGT) 
GMT+08:00 (BORT) 
GMT+08:00 (ULAT) 
GMT+09:00 (JAYT) 
GMT+09:00 (KST) 
GMT+09:00 (JST) 
GMT+09:00 (YAKST) 
GMT+09:00 (PWT) 
GMT+10:00 (EST) 
GMT+10:00 (DDUT) 
GMT+10:00 (VLAST) 
GMT+10:00 (ChST) 
GMT+10:00 (PGT) 
GMT+10:00 (TRUT) 
GMT+11:00 (MAGST) 
GMT+11:00 (VUT) 
GMT+11:00 (SBT) 
GMT+11:00 (KOST) 
GMT+11:00 (NCT) 
GMT+11:00 (PONT) 
GMT+12:00 (NZST) 
GMT+12:00 (ANAST) 
GMT+12:00 (PETST) 
GMT+12:00 (FJT) 
GMT+12:00 (TVT) 
GMT+12:00 (MHT) 
GMT+12:00 (NRT) 
GMT+12:00 (GILT) 
GMT+12:00 (WAKT) 
GMT+12:00 (WFT) 

Bandwidth String 0 = Unlimited Bandwidth 

Notes String  

Email String New user’s contact email 

SendWelcomeMail String [Y | N] 

Return Value: 
If successful, returns <OK/> 
If there is an error, returns <err>%ERROR_MESSAGE%</err> 

Example: 
http://BACKUP_SERVER/obs/api/AddUser.do?SysUser=system&SysPwd=system&LoginName=test&Password=abc&Alias=Testing&La
nguage=en&Email=abc%40abc%2Ecom&Type=PAID&Quota=100000&UserHome=E%3A%5C&EnableMSSQL=Y&EnableMSExchange
=Y&EnableOracle=Y&EnableLotusNotes=Y&EnableLotusDomino=Y&EnableMySQL=Y&EnableInFileDelta=Y&Timezone=GMT%2d08%
3a00+%28PST%29&Contact1=john&Email1=john%40someDomain%2Ecom&Contact2=paul&Email2=paul%40anotherDomain%2Ecom
&EnableExchangeMailbox=Y&ExchangeMailboxQuota=10&ClientType=OBM

18.5 Modifying User Profile 
The following table describes all information required to invoke the [Modify User] API to update a user’s profile in 
an OBS. 

URL: 
http://BACKUP_SERVER/obs/api/ModifyUser.do

Parameters: 
Key Value Descriptions 

SysUser String OBS’s System Username 

SysPwd String OBS’s System password 

LoginName String User’s login name 

Password String User’s password 

http://backup_server/obs/api/UpdateUser.do
http://backup_server/obs/api/AddUser.do?SysUser=system&SysPwd=system&LoginName=test&Password=abc&Alias=Testing&Language=en&Email=abc%40abc%2Ecom&Type=PAID&Quota=100000&UserHome=E%3A%5C&EnableMSSQL=Y&EnableMSExchange=Y&EnableOracle=Y&EnableLotusNotes=Y&EnableLotusDomino=Y&EnableMySQL=Y&EnableInFileDelta=Y&Timezone=GMT%2d08%3a00+%28PST%29&Contact1=john&Email1=john%40someDomain%2Ecom&Contact2=paul&Email2=paul%40anotherDomain%2Ecom&EnableExchangeMailbox=Y&ExchangeMailboxQuota=10&ClientType=OBM
http://backup_server/obs/api/AddUser.do?SysUser=system&SysPwd=system&LoginName=test&Password=abc&Alias=Testing&Language=en&Email=abc%40abc%2Ecom&Type=PAID&Quota=100000&UserHome=E%3A%5C&EnableMSSQL=Y&EnableMSExchange=Y&EnableOracle=Y&EnableLotusNotes=Y&EnableLotusDomino=Y&EnableMySQL=Y&EnableInFileDelta=Y&Timezone=GMT%2d08%3a00+%28PST%29&Contact1=john&Email1=john%40someDomain%2Ecom&Contact2=paul&Email2=paul%40anotherDomain%2Ecom&EnableExchangeMailbox=Y&ExchangeMailboxQuota=10&ClientType=OBM
http://backup_server/obs/api/AddUser.do?SysUser=system&SysPwd=system&LoginName=test&Password=abc&Alias=Testing&Language=en&Email=abc%40abc%2Ecom&Type=PAID&Quota=100000&UserHome=E%3A%5C&EnableMSSQL=Y&EnableMSExchange=Y&EnableOracle=Y&EnableLotusNotes=Y&EnableLotusDomino=Y&EnableMySQL=Y&EnableInFileDelta=Y&Timezone=GMT%2d08%3a00+%28PST%29&Contact1=john&Email1=john%40someDomain%2Ecom&Contact2=paul&Email2=paul%40anotherDomain%2Ecom&EnableExchangeMailbox=Y&ExchangeMailboxQuota=10&ClientType=OBM
http://backup_server/obs/api/AddUser.do?SysUser=system&SysPwd=system&LoginName=test&Password=abc&Alias=Testing&Language=en&Email=abc%40abc%2Ecom&Type=PAID&Quota=100000&UserHome=E%3A%5C&EnableMSSQL=Y&EnableMSExchange=Y&EnableOracle=Y&EnableLotusNotes=Y&EnableLotusDomino=Y&EnableMySQL=Y&EnableInFileDelta=Y&Timezone=GMT%2d08%3a00+%28PST%29&Contact1=john&Email1=john%40someDomain%2Ecom&Contact2=paul&Email2=paul%40anotherDomain%2Ecom&EnableExchangeMailbox=Y&ExchangeMailboxQuota=10&ClientType=OBM
http://backup_server/obs/api/AddUser.do?SysUser=system&SysPwd=system&LoginName=test&Password=abc&Alias=Testing&Language=en&Email=abc%40abc%2Ecom&Type=PAID&Quota=100000&UserHome=E%3A%5C&EnableMSSQL=Y&EnableMSExchange=Y&EnableOracle=Y&EnableLotusNotes=Y&EnableLotusDomino=Y&EnableMySQL=Y&EnableInFileDelta=Y&Timezone=GMT%2d08%3a00+%28PST%29&Contact1=john&Email1=john%40someDomain%2Ecom&Contact2=paul&Email2=paul%40anotherDomain%2Ecom&EnableExchangeMailbox=Y&ExchangeMailboxQuota=10&ClientType=OBM
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Alias String User’s alias 

Language String User’s language, e.g. [ en | cs | da | de | es | fr | fi | is | it | ja | lt | nl | no | pt_PT | sl | sv | zh_TW | 
zh_CN ] 
where 
“en” = English, “cs” = Czech, “da” = Danish, “de” = German, “es” = Spanish, “fr” =French, “fi” = 
Finnish, “is” = Icelandic, “it” =Italian, “ja” = Japanese, “lt” = Lithuanian, “nl” = Dutch, 
“no”=Norwegian, “pt_PT” = Portuguese, “sl” = Slovenian, “sv” = Swedish, “zh_CN” = Chinese 
(Simplified), “zh_TW” = Chinese (Traditional) 

Type String User’s type, e.g. [ TRIAL | PAID ] 

ClientType String User’s client type, e.g. [ OBM | ACB ] 

Status String User’s status, e.g. [ ENABLE | SUSPENDED ] 

Quota Number User’s quota, e.g. 104857600 (for 100MB) 

UserHome String User Home to use for the new user (must be one of the configured user home), e.g. C:\Program 
Files\Ahsay Offsite Backup Server\user 

EnableMSSQL Boolean Whether to enable Microsoft SQL Server module for this user, e.g. [ Y | N ] 

EnableMSExchange Boolean Whether to enable Microsoft Exchange Server module for this user, e.g. [ Y | N ] 

EnableOracle Boolean Whether to enable Oracle module for this user, e.g. [ Y | N ] 

EnableLotusNotes Boolean Whether to enable Lotus Notes module for this user, e.g. [ Y | N ] 

EnableLotusDomino Boolean Whether to enable Lotus Domino module for this user, e.g. [ Y | N ] 

EnableMySQL Boolean Whether to enable MySQL module for this user, e.g. [ Y | N ] 

EnableInFileDelta Boolean Whether to enable In-File Delta module for this user, e.g. [ Y | N ] 

EnableShadowCopy Boolean Whether to enable Shadow Copy module for this user, e.g. [ Y | N ] 

EnableExchangeMailbox Boolean Whether to enable Brick Level Microsoft Exchange module for this user, e.g. [ Y | N ] 

ExchangeMailboxQuota Number The number of Microsoft Exchange mailboxes allowed for this user. 

AppendContact String Whether to append or overwrite contact information [ Y | N ] 

Contact1 String Extra contact name. Notes, There can be more than one extra name added, extra contact name 
must be in pair with extra email below 

Email1 String Extra contact e-mail. Notes, There can be more than one extra email added, extra contact email 
must be in pair with extra contact name above 
User’s time zone setting. It has to be either one of the following entries:  
Please make sure the parameter is properly URL encoded. E.g. GMT-08:00 (PST) => 
GMT%2d08%3a00+%28PST%29 

Timezone String 

GMT-11:00 (WST) 
GMT-11:00 (NUT) 
GMT-11:00 (SST) 
GMT-10:00 (HADT) 
GMT-10:00 (HST) 
GMT-10:00 (TKT) 
GMT-10:00 (HST) 
GMT-10:00 (CKT) 
GMT-10:00 (TAHT) 
GMT-09:00 (AKDT) 
GMT-09:00 (GAMT) 
GMT-08:00 (PST) 
GMT-08:00 (PDT) 
GMT-07:00 (MST) 
GMT-07:00 (MDT) 
GMT-06:00 (CST) 
GMT-06:00 (CDT) 
GMT-06:00 (EAST) 
GMT-06:00 (GALT) 
GMT-05:00 (EST) 
GMT-05:00 (EDT) 
GMT-05:00 (COT) 
GMT-05:00 (ECT) 
GMT-05:00 (CDT) 
GMT-05:00 (PET) 
GMT-05:00 (ACT) 
GMT-05:00 (GMT-
05:00)  
GMT-04:00 (AST) 
GMT-04:00 (PYT) 
GMT-04:00 (VET) 
GMT-04:00 (AMT) 
GMT-04:00 (GYT) 
GMT-04:00 (ADT) 
GMT-04:00 (BOT) 

GMT-04:00 (AMT) 
GMT-04:00 (CLT) 
GMT-04:00 (FKT) 
GMT-03:00 (ART) 
GMT-03:00 (GFT) 
GMT-03:00 (BRT) 
GMT-03:00 (WGST) 
GMT-03:00 (PMDT) 
GMT-03:00 (UYT) 
GMT-03:00 (SRT) 
GMT-02:00 (FNT) 
GMT-02:00 (GST) 
GMT-01:00 (EGST) 
GMT-01:00 (AZOST) 
GMT-01:00 (CVT) 
GMT-01:00 (EGT) 
GMT+00:00 (GMT) 
GMT+00:00 (WET) 
GMT+00:00 (WEST) 
GMT+00:00 (IST) 
GMT+00:00 (BST) 
GMT+00:00 (UTC) 
GMT+01:00 (CET) 
GMT+01:00 (WAT) 
GMT+01:00 (CEST) 
GMT+02:00 (EEST) 
GMT+02:00 (CAT) 
GMT+02:00 (SAST) 
GMT+02:00 (EET) 
GMT+02:00 (IDT) 
GMT+03:00 (EAT) 
GMT+03:00 (AST) 
GMT+03:00 (ADT) 

GMT+03:00 (MSD) 
GMT+04:00 (AQTST) 
GMT+04:00 (AZST) 
GMT+04:00 (GST) 
GMT+04:00 (GEST) 
GMT+04:00 (AMST) 
GMT+04:00 (SAMST) 
GMT+04:00 (SCT) 
GMT+04:00 (MUT) 
GMT+04:00 (RET) 
GMT+05:00 (TMT) 
GMT+05:00 (KGST) 
GMT+05:00 (TJT) 
GMT+05:00 (PKT) 
GMT+05:00 (UZT) 
GMT+05:00 (YEKST) 
GMT+05:00 (IOT) 
GMT+05:00 (TFT) 
GMT+05:00 (MVT) 
GMT+06:00 (MAWT) 
GMT+06:00 (ALMST) 
GMT+06:00 (LKT) 
GMT+06:00 (BDT) 
GMT+06:00 (NOVST) 
GMT+06:00 (BTT) 
GMT+07:00 (ICT) 
GMT+07:00 (JAVT) 
GMT+07:00 (KRAST) 
GMT+07:00 (CXT) 
GMT+08:00 (HKT) 
GMT+08:00 (CST) 
GMT+08:00 (BNT) 
GMT+08:00 (WST) 

GMT+08:00 (IRKST) 
GMT+08:00 (MYT) 
GMT+08:00 (PHT) 
GMT+08:00 (SGT) 
GMT+08:00 (BORT) 
GMT+08:00 (ULAT) 
GMT+09:00 (JAYT) 
GMT+09:00 (KST) 
GMT+09:00 (JST) 
GMT+09:00 (YAKST) 
GMT+09:00 (PWT) 
GMT+10:00 (EST) 
GMT+10:00 (DDUT) 
GMT+10:00 (VLAST) 
GMT+10:00 (ChST) 
GMT+10:00 (PGT) 
GMT+10:00 (TRUT) 
GMT+11:00 (MAGST) 
GMT+11:00 (VUT) 
GMT+11:00 (SBT) 
GMT+11:00 (KOST) 
GMT+11:00 (NCT) 
GMT+11:00 (PONT) 
GMT+12:00 (NZST) 
GMT+12:00 (ANAST) 
GMT+12:00 (PETST) 
GMT+12:00 (FJT) 
GMT+12:00 (TVT) 
GMT+12:00 (MHT) 
GMT+12:00 (NRT) 
GMT+12:00 (GILT) 
GMT+12:00 (WAKT) 
GMT+12:00 (WFT) 

Bandwidth Number 0 = Unlimited Bandwidth 

Notes String  

Return Value: 
If successful, returns <OK/> 
If there is an error, returns <err>%ERROR_MESSAGE%</err> 

Example: 
http://BACKUP_SERVER/obs/api/ModifyUser.do?SysUser=system&SysPwd=system&LoginName=test&Password=abc&Alias=Testing&
Language=en&Type=PAID&Status=ENABLE&Quota=100000&UserHome=E%3A%5C&EnableMSSQL=Y&EnableMSExchange=Y&Ena
bleOracle=Y&EnableLotusNotes=Y&EnableLotusDomino=Y&AppendContact=Y&Contact1=john.john&Email1=john.john%40someDomai

http://backup_server/obs/api/ListUsers.do
http://backup_server/obs/api/RemoveUser.do?SysUser=system&SysPwd=system&LoginName=test
http://backup_server/obs/api/RemoveUser.do
http://backup_server/obs/api/ModifyUser.do?SysUser=system&SysPwd=system&LoginName=test&Password=abc&Alias=Testing&Language=en&Type=PAID&Status=ENABLE&Quota=100000&UserHome=E%3A%5C&EnableMSSQL=Y&EnableMSExchange=Y&EnableOracle=Y&EnableLotusNotes=Y&EnableLotusDomino=Y&AppendContact=Y&Contact1=john.john&Email1=john.john%40someDomain%2Ecom&Contact2=paul&Email2=paul%40anotherDomain%2Ecom&EnableExchangeMailbox=Y&ExchangeMailboxQuota=10&ClientType=OBM
http://backup_server/obs/api/ModifyUser.do?SysUser=system&SysPwd=system&LoginName=test&Password=abc&Alias=Testing&Language=en&Type=PAID&Status=ENABLE&Quota=100000&UserHome=E%3A%5C&EnableMSSQL=Y&EnableMSExchange=Y&EnableOracle=Y&EnableLotusNotes=Y&EnableLotusDomino=Y&AppendContact=Y&Contact1=john.john&Email1=john.john%40someDomain%2Ecom&Contact2=paul&Email2=paul%40anotherDomain%2Ecom&EnableExchangeMailbox=Y&ExchangeMailboxQuota=10&ClientType=OBM
http://backup_server/obs/api/ModifyUser.do?SysUser=system&SysPwd=system&LoginName=test&Password=abc&Alias=Testing&Language=en&Type=PAID&Status=ENABLE&Quota=100000&UserHome=E%3A%5C&EnableMSSQL=Y&EnableMSExchange=Y&EnableOracle=Y&EnableLotusNotes=Y&EnableLotusDomino=Y&AppendContact=Y&Contact1=john.john&Email1=john.john%40someDomain%2Ecom&Contact2=paul&Email2=paul%40anotherDomain%2Ecom&EnableExchangeMailbox=Y&ExchangeMailboxQuota=10&ClientType=OBM
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n%2Ecom&Contact2=paul&Email2=paul%40anotherDomain%2Ecom&EnableExchangeMailbox=Y&ExchangeMailboxQuota=10&ClientT
ype=OBM

18.6 Deleting User 
The following table describes all information required to invoke the [Remove User] API to remove an existing 
user from an OBS. 

URL: 
http://BACKUP_SERVER/obs/api/RemoveUser.do

Parameters: 
Key Value Descriptions 

SysUser String OBS’s System Username 

SysPwd String OBS’s System password 

LoginName String Login name of user to be deleted 

Return Value: 
If successful, returns <OK/> 
If there is an error, returns <err>%ERROR_MESSAGE%</err> 

Example: 
http://BACKUP_SERVER/obs/api/RemoveUser.do?SysUser=system&SysPwd=system&LoginName=test

18.7 Listing Users 
The following table describes all information required to invoke the [List Users] API to get a list of all users 
available within OBS. 

URL: 
http://BACKUP_SERVER/obs/api/ListUsers.do

Parameters: 
Key Value Descriptions 

SysUser String OBS’s System Username 

SysPwd String OBS’s System password 

Return Value: 
If successful, returns 
 
<users> 
<user LoginName="john" Alias=”” UserType=”” ClientType="OBM" Quota=””  

Timezone="GMT+08:00 (CST)" Language="en"  
DataFile="1234" DataSize="1234"  
RetainFile="1234" RetainSize="1234" 
EnableMSSQL="Y" EnableMSExchange="Y" 
EnableOracle="Y" EnableLotusNotes="Y" 
EnableLotusDomino="Y" EnableMySQL="Y" 
EnableInFileDelta="Y" EnableShadowCopy="Y" 
EnableExchangeMailbox=Y ExchangeMailboxQuota=10 
Bandwidth="0" Notes="" 
Status=”ENABLE” RegistrationDate=” 1185249951156” > 

<Contact name="John (Email1)" email="john@yourcompany.com" /> 
<Contact name="John (Email2)" email=" johnmy@yourcompany.com " /> 
</user> 
…
…
</users> 
 

If there is an error, returns <err>%ERROR_MESSAGE%</err> 
Where 

LoginName = login name 
Alias = user’s alias 
UserType = user type [ PAID | TRIAL ] 
ClientType = client type [ OBM | ACB ] 
Quota = quota in bytes 
Timezone = user’s time zone 
Language = user’s language 
DataFile = total number of files in the data area 
DataSize = total amount of bytes in the data area 
RetainFile = total number of files in the retention area 
RetainSize = total amount of bytes in the retention area 
EnableMSSQL = MS SQL enabled [ Y | N ] 
EnableMSExchange = MS Exchange enabled [ Y | N ] 

http://backup_server/obs/api/ModifyUser.do?SysUser=system&SysPwd=system&LoginName=test&Password=abc&Alias=Testing&Language=en&Type=PAID&Status=ENABLE&Quota=100000&UserHome=E%3A%5C&EnableMSSQL=Y&EnableMSExchange=Y&EnableOracle=Y&EnableLotusNotes=Y&EnableLotusDomino=Y&AppendContact=Y&Contact1=john.john&Email1=john.john%40someDomain%2Ecom&Contact2=paul&Email2=paul%40anotherDomain%2Ecom&EnableExchangeMailbox=Y&ExchangeMailboxQuota=10&ClientType=OBM
http://backup_server/obs/api/ModifyUser.do?SysUser=system&SysPwd=system&LoginName=test&Password=abc&Alias=Testing&Language=en&Type=PAID&Status=ENABLE&Quota=100000&UserHome=E%3A%5C&EnableMSSQL=Y&EnableMSExchange=Y&EnableOracle=Y&EnableLotusNotes=Y&EnableLotusDomino=Y&AppendContact=Y&Contact1=john.john&Email1=john.john%40someDomain%2Ecom&Contact2=paul&Email2=paul%40anotherDomain%2Ecom&EnableExchangeMailbox=Y&ExchangeMailboxQuota=10&ClientType=OBM
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EnableOracle = Oracle enabled [ Y | N ] 
EnableLotusNotes = Lotus Notes enabled [ Y | N ] 
EnableLotusDomino = Lotus Domino enabled [ Y | N ] 
EnableMySQL = MySQL enabled [ Y | N ] 
EnableInFileDelta = In-file Delta enabled [ Y | N ] 
EnableShadowCopy = Shadow Copy enabled [ Y | N ] 
EnableExchangeMailbox = MS Exchange Mailbox enabled [ Y | N ] 
ExchangeMailboxQuota = MS Exchange Mailbox quota 
Bandwidth = user’s bandwidth 
Notes = user’s notes 
Status = status of user account [ENABLE | SUSPENDED] (added since v.5.2.2.5) 
RegistrationDate = registation date of user account (added since v.5.2.2.5) 

Example: 
http://BACKUP_SERVER/obs/api/ListUsers.do?SysUser=system&SysPwd=system

18.8 Getting User Information 
The following table describes all information required to invoke the [Get User] API to get a user’s account 
information. 

URL: 
http://BACKUP_SERVER/obs/api/GetUser.do

Parameters: 
Key Value Descriptions 

SysUser String OBS’s System Username 

SysPwd String OBS’s System password 

LoginName String The user’s login name 

Return Value: 
If successful, returns 
 
<user LoginName="john" Alias=”” UserType=”PAID” ClientType="OBM"  

Status=”ENABLE” Quota=”53687091200” 
Timezone="GMT+08:00 (CST)" Language="en"  
DataFile="1234" DataSize="1234"  
RetainFile="1234" RetainSize="1234" 
UncompressedSize="55837504" 
EnableMSSQL="Y" EnableMSExchange="Y" 
EnableOracle="Y" EnableLotusNotes="Y" 
EnableLotusDomino="Y" EnableMySQL="Y" 
EnableInFileDelta="Y" EnableShadowCopy="Y" 
ExchangeMailboxQuota="0" Bandwidth="0" Notes=""  
UserHome=”C:\Program Files\Offsite Backup Server\user\john”  
RegistrationDate=”1185249951156” MailboxUsage="11" > 

<Contact name="John (Email1)" email="john@yourcompany.com" /> 
<Contact name="John (Email2)" email="johnmy@yourcompany.com" /> 
</user> 
 

If there is an error, it returns <err>%ERROR_MESSAGE%</err> 
Where 

LoginName = login name 
Alias = user’s alias 
UserType = user type [ PAID | TRIAL ] 
ClientType = client type [ OBM | ACB ] 
Status = status of user account [ENABLE | SUSPENDED] (added since v.5.2.2.5) 
Quota = quota in bytes 
Timezone = user’s timezone 
Language = user’s language 
DataFile = total number of files in the data area 
DataSize = total amount of bytes in the data area 
RetainFile = total number of files in the retention area 
RetainSize = total amount of bytes in the retention area 
UncompressedSize = total amount (bytes) of uncompressed file size in data area 
EnableMSSQL = MS SQL enabled [ Y | N ] 
EnableMSExchange = MS Exchange enabled [ Y | N ] 
EnableOracle = Oracle enabled [ Y | N ] 
EnableLotusNotes = Lotus Notes enabled [ Y | N ] 
EnableLotusDomino = Lotus Domino enabled [ Y | N ] 
EnableMySQL = MySQL enabled [ Y | N ] 
EnableInFileDelta = In-file Delta enabled [ Y | N ] 
EnableShadowCopy = Shadow Copy enabled [ Y | N ] 
EnableExchangeMailbox = MS Exchange Mailbox enabled [ Y | N ] 
ExchangeMailboxQuota = MS Exchange Mailbox quota 
Bandwidth = user’s bandwidth 
Notes = user’s notes 

http://backup_server/obs/api/GetUser.do
http://backup_server/obs/api/ListUsers.do?SysUser=system&SysPwd=system
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UserHome = the directory where OBS stores the backup files and backup logs (added since v.5.2.2.5) 
RegistrationDate = registation date of user account (added since v.5.2.2.5) 
MailboxUsage = the number of mailboxes used (added since v5.2.5.0) 

Example: 
http://BACKUP_SERVER/obs/api/GetUser.do?SysUser=system&SysPwd=system&LoginName=John

18.9 Adding a Backup Set 
The following table describes all information required to invoke the [Add Backup Set] API to add a new backup 
set. 

URL: 
http://BACKUP_SERVER/obs/api/AddBackupSet.do

Parameters: 
Key Value Descriptions 

SysUser String OBS’s System Username 

SysPwd String OBS’s System password 

LoginName String The user’s login name 

Return Value: 
If successful, returns 
 
<BackupSet ID="1122260638375"></BackupSet > 
 

If there is an error, returns <err>%ERROR_MESSAGE%</err> 
where 

ID = new backup set ID 

Example: 
http://BACKUP_SERVER/obs/api/AddBackupSet.do?SysUser=system&SysPwd=system&LoginName=John

18.10 Deleting a Backup Set 
The following table describes all information required to invoke the [Delete Backup Set] API to delete a backup 
set for a particular user. 

URL: 
http://BACKUP_SERVER/obs/api/DeleteBackupSet.do

Parameters: 
Key Value Descriptions 

SysUser String OBS’s System Username 

SysPwd String OBS’s System password 

LoginName String The user’s login name 

BackupSetID String The ID of the backup set to delete 

Return Value: 
If successful, returns <OK/> 
If there is an error, returns <err>%ERROR_MESSAGE%</err> 

Example: 
http://BACKUP_SERVER/obs/api/DeleteBackupSet.do?SysUser=system&SysPwd=system&LoginName=John&BackupSetID=11222606
38375

18.11 Listing Backup Sets  
The following table describes all information required to invoke the [List Backup Sets] API to list all the backup 
sets for a particular user. 

URL: 
http://BACKUP_SERVER/obs/api/ListBackupSets.do

Parameters: 
Key Value Descriptions 

SysUser     String OBS’s System Username 

SysPwd String OBS’s System password 

LoginName String The user’s login name 

http://backup_server/obs/api/ListBackupSets.do
http://backup_server/obs/api/DeleteBackupSet.do?SysUser=system&SysPwd=system&LoginName=John&BackupSetID=1122260638375
http://backup_server/obs/api/DeleteBackupSet.do?SysUser=system&SysPwd=system&LoginName=John&BackupSetID=1122260638375
http://backup_server/obs/api/DeleteBackupSet.do
http://backup_server/obs/api/AddBackupSet.do?SysUser=system&SysPwd=system&LoginName=John
http://backup_server/obs/api/AddBackupSet.do
http://backup_server/obs/api/GetUser.do?SysUser=system&SysPwd=system&LoginName=John
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Return Value: 
If successful, returns 
 
<BackupSets> 
<BackupSet ID="1099561060222" Name="BackupSet-1" Type="File" /> 
<BackupSet ID="1099561060223" Name="BackupSet-2" Type="Microsoft SQL Server" /> 
<BackupSet ID="1099561060224" Name="BackupSet-3" Type="Oracle Database Server" /> 
<BackupSet ID="1099561060225" Name="BackupSet-4" Type="Microsoft Exchange Server" /> 
<BackupSet ID="1099561060226" Name="BackupSet-5" Type="Lotus Domino" /> 
<BackupSet ID="1099561060227" Name="BackupSet-6" Type="Lotus Notes" /> 
<BackupSet ID="1099561060228" Name="BackupSet-7" Type="MySQL" /> 
<BackupSet ID="1099561060229" Name="BackupSet-8" Type="System State" /> 
<BackupSet ID="1099561060230" Name="BackupSet-9" Type=" Microsoft Exchange Mail" /> 
<BackupSet ID="1099561060231" Name="BackupSet-10" Type=" Microsoft Exchange Mail (MAPI)" /> 
</BackupSets> 
 

If there is an error, returns <err>%ERROR_MESSAGE%</err> 
where 

ID = backup set ID 
Name = backup set name 
Type = backup set type 

Example: 
http://BACKUP_SERVER/obs/api/ListBackupSets.do?SysUser=system&SysPwd=system&LoginName=John

18.12 Getting a Backup Set  
The following table describes all information required to invoke the [Get Backup Set] API to get a backup set. 

URL: 
http://BACKUP_SERVER/obs/api/GetBackupSet.do

Parameters: 
Key Value Descriptions 

SysUser     String OBS’s System Username 

SysPwd String OBS’s System password 

LoginName String The user’s login name 

BackupSetID String The backup set ID 

Return Value: 
If successful, returns 
 
<BackupSet ID="1065821983562"  
Name="FileBackupSet-1"  
TransferBlockSize="131072" FollowSymbolicLink="N" Type="FILE"  
AdminUsername="" AdminPassword="" WorkingDir="D:\temp"  
OracleSID="" Port="" Host=""  
LogRetentionDays="60" NotesINI="" BackupSystemState="N"  
LanDomain="" LanUsername="" LanPassword=""  
LastBackupRun="1168658269937" LastBackupAccess="1168658296640"  
EnableInFileDelta="Y" MinDeltaFileSize="26214400" DeltaBlockSize="-1" MaxNumOfDelta="100" MaxDeltaRatio="50" 
EnableShadowCopy="Y" EnableOfflineBackup="Y" EnableLogoutBackup="Y" FullBackup="N" LastBackupCompleted="1168658297156" 
BackupIntervalDay="1" BackupIntervalHour="0" LogoutType="" OfflineNotificiationDay="7" DeleteTempFile="N" SqlServer="" 
DefaultDeltaType="I" TotalUncompressedDataSize="2988032" NumberOfFiles="6" TotalBackupSetSize="1064224" 
TotalBSetRetainUncompress="139301468" TotalBSetRetainFileNo="92" TotalBsetRetainFileSize="40579168" ScheduleHost="John"> 
 
<SelectedSource>E:\temp\Test.txt</SelectedSource> 
<SelectedSource>D:\Outlook</SelectedSource> 
 
<DailySchedule ID="1168669116421" Name="BackupSchedule" Hour="23" Minute="0" Duration="-1" BackupType="FILE"/> 
<WeeklySchedule ID="1168669135671" Name="BackupSchedule" Sun="N" Mon="N" Tue="N" Wed="N" Thu="N" Fri="N" Sat="Y" 
Hour="23" Minute="0" Duration="8" BackupType="FILE"/> 
<MonthSchedule ID="1168669142593" Name="BackupSchedule" Occurrenace="First" Criteria="Day" Date="1" Hour="23" Minute="0" 
Duration="-1" BackupType="FILE"/> 
<CustomSchedule ID="1168669167078" Name="BackupSchedule" BackupType="FILE" Date="2007-12-31" Hour="23" Minute="0" 
Duration="-1"/> 
 
<Filter ID="1168669208375" Name="Filter-1" Type="END_WITH" TopDir="C:\" Include="Y" Only="N" ApplyToDir="N" 
ApplyToFile="Y"><Pattern>*.doc</Pattern></Filter> 
 
<RetentionPolicy Unit="CUSTOMIZE" Period="7"> 
<RetentionSetting ID="1168669352281" Name="" OverlapSensitive="Y"> 
<Setting ID="1168669443453" Name="Retention Policy-1" Type="DAILY" NumOfCopiesToKeep="7" DateType="" Sun="N" Mon="N" 
Tue="N" Wed="N" Thu="N" Fri="N" Sat="N" Day="1" Week="1" Month="1" Year="2007"/> 
<Setting ID="1168669452343" Name="Retention Policy-2" Type="WEEKLY" NumOfCopiesToKeep="4" DateType="" Sun="N" Mon="N" 
Tue="N" Wed="N" Thu="N" Fri="N" Sat="Y" Day="1" Week="1" Month="1" Year="2007"/> 
<Setting ID="1168669466796" Name="Retention Policy-3" Type="MONTHLY" NumOfCopiesToKeep="12" DateType="EXACT" Sun="N" 

http://backup_server/obs/api/GetBackupSet.do
http://backup_server/obs/api/ListBackupSets.do?SysUser=system&SysPwd=system&LoginName=John
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Mon="N" Tue="N" Wed="N" Thu="N" Fri="N" Sat="N" Day="1" Week="1" Month="1" Year="2007"/> 
<Setting ID="1168669484781" Name="Retention Policy-4" Type="QUARTERLY" NumOfCopiesToKeep="4" DateType="EXACT" 
Sun="N" Mon="N" Tue="N" Wed="N" Thu="N" Fri="N" Sat="N" Day="32" Week="1" Month="1" Year="2007"/> 
<Setting ID="1168669493468" Name="Retention Policy-5" Type="YEARLY" NumOfCopiesToKeep="7" DateType="EXACT" Sun="N" 
Mon="N" Tue="N" Wed="N" Thu="N" Fri="N" Sat="N" Day="1" Week="1" Month="1" Year="2007"/> 
<Setting ID="1168669503984" Name="Retention Policy-6" Type="CUSTOM" NumOfCopiesToKeep="7" DateType="EXACT" Sun="N" 
Mon="N" Tue="N" Wed="N" Thu="N" Fri="N" Sat="N" Day="25" Week="1" Month="12" Year="2007"/> 
</RetentionSetting> 
</RetentionPolicy> 
 
<PreBackupCommand ID="1168669311468" Name="Pre-backup Command-1" Path="pre-command.bat" WorkingDir="D:\"/> 
<PostBackupCommand ID="1168669328625" Name="Post-backup Command-1" Path="post-command.bat" WorkingDir="D:\"/> 
 
<ExtraLocalBackup ENABLED="Y" Zip="N" BackupTo="C:\LocalBackup" SkipOffsiteBackup="N" SetLocalCopyPermission="N"/> 
<DeltaWeeklySchedule Sun="" Mon="" Tue="" Wed="" Thu="" Fri="" Sat="D"/> 
<DeltaMonthlySchedule Date="1" Occurrenace="First" Criteria="Friday" JAN="F" FEB="F" MAR="F" APR="F" MAY="F" JUN="F" 
JUL="F" AUG="F" SEP="F" OCT="F" NOV="F" DEC="F"/> 
 
</BackupSet> 
 

If there is an error, returns 
<err>[UserCacheManager] User 'Johnny' not found.</err> 
<err>Backup Set for ID='1065821983563' not found</err> 
where under 
Tag <BACKUP_SET> 

ID = backup set ID 
Name = backup set name 
TransferBlockSize = block size for transfer 
FollowSymbolicLink = follow symbolic link (Linux only) 
Type = backup set type 
AdminUsername = administrator user name 
AdminPassword = administrator password 
WorkingDir = temporary working directory 
OracleSID = Oracle SID setting 
Port = Oracle port number 
Host = Oracle hostname 
LogRetentionDays = retention day logging 
NotesINI = path location of notes.ini file 
BackupSystemState = whether to backup system state 
LanDomain = LAN domain name 
LanUsername = LAN user name 
LanPassword = LAN password 
LastBackupRun = time of last backup run 
LastBackupAccess = time of last backup 
EnableInFileDelta = enabling in-file delta feature 
MinDeltaFileSize = minimum delta file size setting field 
DeltaBlockSize = delta block size setting field 
MaxNumOfDelta = maximum delta number setting field 
MaxDeltaRatio = maximum delta ratio setting field 
EnableShadowCopy = enabling shadow copy feature field 
EnableOfflineBackup = enabling offline copy feature filed 
EnableLogoutBackup = enabling logout backup feature field 
FullBackup = enabling full backup field 
LastBackupCompleted = time when the last backup was completed 
BackupIntervalDay = Offline backup day interval 
BackupIntervalHour = Offline backup hour interval 
LogoutType = unused 
OfflineNotificiationDay = Offline backup email reminder days 
DeleteTempFile = Remove temporary files after backup 
SqlServer = SQL server hostname 
DefaultDeltaType = Default in-file delta type 
TotalUncompressedDataSize = Total uncompressed size in bytes of the data area 
NumberOfFiles = Total number of files in the data area 
TotalBackupSetSize = Total compressed size in bytes of the data area 
TotalBSetRetainUncompress = Total uncompressed size in bytes of the retention area 
TotalBSetRetainFileNo = Total number of files in the retention area 
TotalBsetRetainFileSize = Total compressed size in bytes of the retention area 
ScheduleHost = Computer name of this backup set that the scheduler will use to determine whether to run 

Tag < SelectedSource > 
SelectedSource = selected sources for backup 

Tag < DeseletedSource > 
DeseletedSource = deselected sources for backup 

Tag < DailySchedule > 
ID = schedule ID 
Name = schedule name 
Hour = time setting for such schedule 
Minute = time setting for such schedule 
Duration = how long to run. Use -1 for “Stop on completion” 
BackupType = Backup set type 

Tag < WeeklySchedule > 
ID = schedule ID 

http://backup_server/obs/api/GetBackupSet.do?SysUser=system&SysPwd=system&LoginName=John&BackupSetID=1077097041763
http://backup_server/obs/api/GetBackupSet.do?SysUser=system&SysPwd=system&LoginName=John&BackupSetID=1077097041763


We back up your business 
Ahsay Offsite Backup Server v5.2

Administrator’s Guide

Ahsay Systems Corporation Limited Page 68 of 85 (April 15, 2008)

Name = schedule name 
Sun = enable field 
Mon = enable field 
Tue = enable field 
Wed –enable field 
Thu = enable field 
Fri = enable field 
Sat = enable field 
Hour = time setting for such schedule 
Minute = time setting for such schedule 
Duration = how long to run. Use -1 for “Stop on completion” 
BackupType = Backup set type 

Tag < MonthSchedule > 
ID = schedule ID 
Name = schedule name 
Date = exact day of the month. When “0” use occurrence and criteria. 
Occurrence= occurrence to run e.g. First, Second, Third, Forth Last 
Criteria = day to run e.g. Monday, Tuesday, Wednesday, Thursday, Friday, Saturday, Sunday 
Hour = time setting for such schedule 
Minute = time setting for such schedule 
Duration = how long to run. Use -1 for “Stop on completion” 
BackupType = Backup set type 

Tag < CustomSchedule > 
ID = schedule ID 
Name = schedule name 
BackupType = Backup set type 
Date = the date to run this schedule 
Hour = time setting for such schedule 
Minute = time setting for such schedule 
Duration = how long to run. Use -1 for “Stop on completion” 

Tag < Filter> 
ID = filter ID 
Name = filter name 
Type = filter type 
TopDir = the top most directory to apply this filter 
Include = filter mode 
Only = filter mode 
ApplyToDir = applying to such directory 
ApplyToFile = applying to such file 

Tag < Pattern> 
Pattern = the filter pattern to apply 

Tag < RetentionPolicy > 
Unit= type for the retention policy, by JOB, DAYS, or CUSTOMIZE 
Period= days for the policy 

Tag < RetentionSetting > 
ID = retention ID 
OverlapSensitive = enable feature setting 

Tag < Setting> 
ID = retention ID 
Name = retention name 
Type = retention type. Allowed values are [DAILY | WEEKLY | MONTHLY | QUARTERLY | YEARLY | CUSTOM 
NumOfCopiesToKeep = number of copies to keep 
DateType = normally empty. Use “EXACT” when the date is known. 
Sun, Mon, Tue, Wed, Thu, Fri, Sat = days enabled 
Day, Week, Month, Year = date enabled 

Tag < PreBackupCommand> 
ID = pre-command ID 
Name = pre-command name 
Path = path for such pre command 
WorkingDir = directory for such pre-command 

Tag < PostBackupCommand > 
ID = post command ID 
Name = post command name 
Path = path for such post command 
WorkingDir = directory for such post command 

Tag < ExtraLocalBackup > 
ENABLED = enable “Extra Local Copy” feature field 
Zip = zip the copied file feature 
BackupTo = location to save extra copy 
SkipOffsiteBackup = whether to skip off-site backup 
SetLocalCopyPermission = set local copy permission 

Tag < DeltaWeeklySchedule> 
Sun, Mon, Tue, Wed, Thu, Fri, Sat = advance delta weekly schedule enabled. [ I | D | F ] 

Tag < DeltaMonthlySchedule> 
Date = exact day of the month. When “0” use occurrence and criteria. 
Occurrence= occurrence to run e.g. First, Second, Third, Forth Last 
Criteria = day to run e.g. Monday, Tuesday, Wednesday, Thursday, Friday, Saturday, Sunday 
Jan, Feb, Mar, Apr, May, Jun, Jul, Aug, Sep, Oct, Nov, Dec = advance monthly schedule enabled. [ I | D | F ] 

Example: 
http://BACKUP_SERVER/obs/api/GetBackupSet.do?SysUser=system&SysPwd=system&LoginName=John&BackupSetID=1077097041
763
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18.13 Updating a Backup Set  
The following table describes all information required to invoke the [Update Backup Set] API to update a backup 
set. Note, use [Get Backup Set] API above to retrieve a backup set and save it as an xml file; modify the file as 
you need, and post it as a content using parameter name “Profile” when calling [Update Backup Set] API 

URL: 
http://BACKUP_SERVER/obs/api/UpdateBackupSet.do

Parameters: 
Key Value Descriptions 

SysUser String OBS’s System Username 

SysPwd String OBS’s System password 

LoginName String The user’s login name 

Profile String The whole content of backup set in XML format posted up when calling this API 

Return Value: 
If successful, returns <OK/> 
If there is an error, returns <err>%ERROR_MESSAGE%</err> 

Example: 
http://BACKUP_SERVER/obs/api/UpdateBackupSet.do?SysUser=system&SysPwd=system&LoginName=John

18.14 Listing Backup Jobs 
The following table describes all information required to invoke the [List Backup Jobs] API to get a list of all 
backup jobs for all backup sets. 

URL: 
http://BACKUP_SERVER/obs/api/ListBackupJobs.do

Parameters: 
Key Value Descriptions 

SysUser String OBS’s System Username 

SysPwd String OBS’s System password 

LoginName String The user’s login name 

Return Value: 
If successful, returns 
 
<BackupSets> 
<BackupSet ID="1121746638656"> 
<BackupJob ID="2005-12-29-12-00-00" /> 
<BackupJob ID="2005-12-30-12-00-00" /> 
<BackupJob ID="2005-12-31-12-00-00" /> 
</BackupSet> 
…
</BackupSets> 
 

If there is an error, returns <err>%ERROR_MESSAGE%</err> 
Where under 
Tag <BackupSet> 

ID = backup set ID 
Tag <BackupJob> 

ID = backup job ID 

Example: 
http://BACKUP_SERVER/obs/api/ListBackupJobs.do?SysUser=system&SysPwd=system&LoginName=John

18.15 Listing Backup Job Status 
The following table describes all information required to invoke the [List Backup Job Status] API to get a list of all 
backup jobs for all backup sets. 

URL: 
http://BACKUP_SERVER/obs/api/ListBackupJobStatus.do

Parameters: 
Key Value Descriptions 

SysUser String OBS’s System Username 

http://backup_server/obs/api/ListBackupJobStatus.do
http://backup_server/obs/api/ListBackupJobs.do?SysUser=system&SysPwd=system&LoginName=John
http://backup_server/obs/api/ListBackupJobs.do
http://backup_server/obs/api/UpdateBackupSet.do?SysUser=system&SysPwd=system&LoginName=John
http://backup_server/obs/api/UpdateBackupSet.do
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SysPwd String OBS’s System password 

LoginName String The user’s login name. Optional argument, if specified, only the backup jobs of the user is 
displayed otherwise all backup jobs are displayed. 

BackupDate String A date in YYYY-MM-DD format 

Return Value: 
If successful, returns 
 
<BackupJobs BackupDate="2007-01-02" > 
<BackupJob ID="2007-01-02-02-01-01" LoginName="demo" StartTime="2007-01-02 02:01:01" EndTime="2007-01-02 02:01:04" 
BackupJobStatus="BS_STOP_SUCCESS" BackupSetID="1190692945178" /> 
<BackupJob ID="2007-01-02-16-45-45" LoginName="demo" StartTime="2007-01-02 16:45:45" EndTime="2007-01-02 16:45:48" 
BackupJobStatus="BS_STOP_SUCCESS" BackupSetID="1190692945178" />  
</BackupJobs> 
 

If there is an error, it returns <err>%ERROR_MESSAGE%</err> 
where under 
Tag <BackupJobs> 

BackupDate = date of backup 
Tag <BackupJob> 

ID = backup job ID 
LoginName = user name 
StartTime = job start time 
EndTime = job end time 
BackupJobStatus = the status of the backup job as follow: 

1. BS_STOP_SUCCESS = backup completed successfully 
2. BS_STOP_BY_SYSTEM_ERROR = backup stopped due to system error 
3. BS_STOP_BY_SCHEDULER = backup stopped by scheduler 
4. BS_STOP_BY_USER = backup stopped by user 
5. BS_STOP_BY_QUOTA_EXCEEDED = backup stopped due to quota exceeded 
6. BS_STOP_SUCCESS_WITH_ERROR = backup completed with errors 
7. BS_STOP_SUCCESS_WITH_WARNING = backup completed with warnings 
8. BS_STOP_MISSED_BACKUP = backup missed 
9. Empty = backup in progress 
10. Others = other client errors not defined above. 

BackupSetID = backup set ID (added since v5.2.5.0) 

Example: 
http://BACKUP_SERVER/obs/api/ListBackupJobStatus.do?SysUser=system&SysPwd=system&LoginName=John&BackupDate=2007-
01-08

18.16 Getting Backup Job Report  
The following table describes all information required to invoke the [Get Backup Job Report] API to get a backup 
job status. 

URL: 
http://BACKUP_SERVER/obs/api/GetBackupJobReport.do

Parameters: 
Key Value Descriptions 

SysUser String OBS’s System Username 

SysPwd String OBS’s System password 

LoginName String The user’s login name 

BackupSetID String A backup set ID 

BackupJobID String A backup job ID 

Return Value: 
If successful, returns 
 
<BackupJob ID="2005-07-19-12-11-20" StartTime=" 2005-07-19 12:11:20"  
 EndTime="2005-07-19 12:21:20" JobStatus="BS_STOP_SUCCESS"  
 NumOfErrorEntries="0" NumOfWarnEntries="0" 
 NumOfNewFiles="1" TotalNewFilesSize="37487104"  
 NumOfUpdatedFiles="1" TotalUpdatedFilesSize="37487104"  
 NumOfDeletedFiles="1" TotalDeletedFilesSize="37487104" 
 NumOfMovedFiles="1" TotalMovedFilesSize="37487104" > 
 
<Info Timestamp="2005-12-31 12:59:59" Message="??????" /> 
... 
<Warn Timestamp="2005-12-31 12:59:59" Message="??????" /> 
... 
<Error Timestamp="2005-12-31 12:59:59" Message="??????" /> 
... 
<NewFile LastModified="2005-12-31 12:59:59" Name="C:\abc.doc"  
 FileSize="374 LastModified="2005-12-31 12:59:59"/> 
... 

http://backup_server/obs/api/GetBackupJobReport.do
http://backup_server/obs/api/ListBackupJobStatus.do?SysUser=system&SysPwd=system&LoginName=John&BackupDate=2007-01-08
http://backup_server/obs/api/ListBackupJobStatus.do?SysUser=system&SysPwd=system&LoginName=John&BackupDate=2007-01-08
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<UpdatedFile LastModified="2005-12-31 12:59:59" Name="C:\abc.doc"  
 FileSize="374 LastModified="2005-12-31 12:59:59"/> 
... 
<DeletedFile LastModified="2005-12-31 12:59:59" Name="C:\abc.doc"  
 FileSize="374 LastModified="2005-12-31 12:59:59"/> 
... 
<MovedFile LastModified="2005-12-31 12:59:59" FromFile="C:\abc.doc" ToFile="C:\abc.doc" 
 FileSize="374 LastModified="2005-12-31 12:59:59"/> 
... 
</BackupJob> 
 

If there is an error, returns <err>%ERROR_MESSAGE%</err> 
where under 
Tag <BackupJob> 

ID = backup job ID 
StartTime = backup job start time 
EndTime = backup job end time 
JobStatus = status of backup job 
NumOfErrorEntries = number of backup job errors 
NumOfWarnEntries = number of backup job warnings 
NumOfNewFiles = number of new files 
TotalNewFilesSize = new files size 
NumOfUpdatedFiles = number of updated files 
TotalUpdatedFilesSize = updated files size 
NumOfDeletedFiles = number of deleted files 
TotalDeletedFilesSize = deleted files size 
NumOfMovedFiles = number of moved files 
TotalMovedFilesSize = move files size 

Tag <Info>, <Warn>, <Error> 
TimeStamp = time of this message 
Message = message text 

Tag <NewFile>, <UpdatedFile>, <DeletedFile>,<MovedFile> 
Name = filename 
FileSize = filesize 
LastModified = last modified time of such file 

 

Example: 
http://BACKUP_SERVER/obs/api/GetBackupJobReport.do?SysUser=system&SysPwd=system&LoginName=john&BackupSetID=11083
78758790&BackupJobID=2007-01-08-16-02-07

18.17 Getting Backup Job Report Summary 
The following table describes all information required to invoke the [Get Backup Job Report Summary] API to get 
a backup job status. 

URL: 
http://BACKUP_SERVER/obs/api/GetBackupJobReportSummary.do

Parameters: 
Key Value Descriptions 

SysUser String OBS’s System Username 

SysPwd String OBS’s System password 

LoginName String The user’s login name 

BackupSetID String A backup set ID 

BackupJobID String A backup job ID 

Return Value: 
If successful, returns 
 
<BackupJob ID="2007-01-08-16-02-07" StartTime="2007-01-08 16:02:07"  
 EndTime="2007-01-08 16:02:12" BackupJobStatus="BS_STOP_SUCCESS"  
 NumOfWarnEntries="0" NumOfErrorEntries="0"  
 NumOfNewFiles="15" TotalNewFilesSize="790256"  
 NumOfUpdatedFiles="0" TotalUpdatedFilesSize="0"  
 NumOfDeletedFiles="0" TotalDeletedFilesSize="0"  
 NumOfMovedFiles="0" TotalMovedFilesSize="0" 
 NumOfUpdatedPermissionFiles="0" TotalUpdatedPermissionFilesSize="0"> 
</BackupJob> 
 

If there is an error, returns <err>%ERROR_MESSAGE%</err> 
where under 
Tag <BackupJob> 

ID = backup job ID 
StartTime = backup job start time 
EndTime = backup job end time 

http://backup_server/obs/api/GetBackupJobReportSummary.do
http://backup_server/obs/api/GetBackupJobReport.do?SysUser=system&SysPwd=system&LoginName=john&BackupSetID=1108378758790&BackupJobID=2007-01-08-16-02-07
http://backup_server/obs/api/GetBackupJobReport.do?SysUser=system&SysPwd=system&LoginName=john&BackupSetID=1108378758790&BackupJobID=2007-01-08-16-02-07
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JobStatus = status of backup job 
NumOfErrorEntries = number of backup job errors 
NumOfWarnEntries = number of backup job warnings 
NumOfNewFiles = number of new files 
TotalNewFilesSize = new files size 
NumOfUpdatedFiles = number of updated files 
TotalUpdatedFilesSize = updated files size 
NumOfDeletedFiles = number of deleted files 
TotalDeletedFilesSize = deleted files size 
NumOfMovedFiles = number of moved files 
TotalMovedFilesSize = move files size 
NumOfUpdatedPermissionFiles = number of updated file permission files (added since v5.2.5.0) 
TotalUpdatedPermissionFilesSize = updated file permission files size (added since v5.2.5.0) 

Example: 
http://BACKUP_SERVER/obs/api/GetBackupJobReportSummary.do?SysUser=system&SysPwd=system&LoginName=john&BackupSetI
D=1108378758790&BackupJobID=2007-01-08-16-02-07

18.18 Listing Backup Files  
The following table describes all information required to invoke the [List Backup Files] API to get all backup files 
by given a directory. 

URL: 
http://BACKUP_SERVER/obs/api/ListBackupFiles.do

Parameters: 
Key Value Descriptions 

SysUser String OBS’s System Username 

SysPwd String OBS’s System password 

LoginName String The user’s login name 

BackupSetID String A backup set ID 

BackupJobID String A backup job ID 

Path String A directory path 

Return Value: 
If successful, returns 
 
<Files> 
<File Type="DIR" Name="My Document Folder" /> 
<File Type="FILE" Name="changeStatus.bat"  
 OriginalFileSize="187" FileSize="1712"  
 BackupByJob="2005-07-25-17-07-07" InBackupJob="Current"  
 LastModified="1109233592750" /> 
</Files> 
 

If there is an error, returns <err>%ERROR_MESSAGE%</err> 
where under 

Name = name of the file 
OriginalFileSize = the first size of the file when first uploading 
FileSize = the file size while doing uploading 
BackupedByJob = the day when such file uploaded 
InBackupJob = The file which has been updated 
LastModified = The time of last modification 

Example: 
http://BACKUP_SERVER/obs/api/ListBackupFiles.do?SysUser=system&SysPwd=system&LoginName=john&BackupSetID=1108378758
790&BackupJobID=2007-001-08-16-02-07&Path=C:\Documents%20and%20Settings\john.my.company.

18.19 Getting User Storage Statistics  
The following table describes all information required to invoke the [Getting User Storage Statistics] API to get a 
list of storage information for a user. 

URL: 
http://BACKUP_SERVER/obs/api/GetUserStorageStat.do

Parameters: 
Key Value Descriptions 

SysUser String OBS’s System Username 

SysPwd String OBS’s System password 

LoginName String The user’s login name 

http://backup_server/obs/api/GetStatistics.do
http://backup_server/obs/api/ListBackupFiles.do?SysUser=system&SysPwd=system&LoginName=john&BackupSetID=1108378758790&BackupJobID=2007-001-08-16-02-07&Path=C:\Documents%20and%20Settings\john.my.company.
http://backup_server/obs/api/ListBackupFiles.do?SysUser=system&SysPwd=system&LoginName=john&BackupSetID=1108378758790&BackupJobID=2007-001-08-16-02-07&Path=C:\Documents%20and%20Settings\john.my.company.
http://backup_server/obs/api/ListBackupFiles.do
http://backup_server/obs/api/GetBackupJobReportSummary.do?SysUser=system&SysPwd=system&LoginName=john&BackupSetID=1108378758790&BackupJobID=2007-01-08-16-02-07
http://backup_server/obs/api/GetBackupJobReportSummary.do?SysUser=system&SysPwd=system&LoginName=john&BackupSetID=1108378758790&BackupJobID=2007-01-08-16-02-07
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YearMonth String Year and month (yyyy-MM) 

Return Value: 
If successful, returns 
 
<Statistics YearMonth="2005-07"  
 AvgDataSize="" AvgDataRawSize =”” AvgDataNo=""  
 AvgRetainSize="" AvgRetainRawSize= “” AvgRetainNo=""  
 AvgUploadSize="" AvgUploadRawSize=”” AvgUploadNo=""  
 AvgTotalStorageSize="" AvgTotalStorageRawSize=”” AvgTotalStorageNo="" > 
 <Storage Date="2005-07-25"  
 DataSize="0" DataRawSize=”0” DataNo="0"  
 RetainSize="0" RetainRawSize="0" RetainNo="0"  
 UploadSize="0" UploadRawSize="0" UploadNo="0"  
 TotalStorageSize="0" TotalStorageRawSize="0" TotalStorageNo="0" /> 
 <Storage Date="2005-07-26"  
 DataSize="0" DataRawSize="0"DataNo="0"  
 RetainSize="0" RetainRawSize="0" RetainNo="0"  
 UploadSize="0" UploadRawSize="0"UploadNo="0"  
 TotalStorageSize="0" TotalStorageRawSize="0"TotalStorageNo="0" /> 
</Statistics> 
 

If there is an error, returns <err>%ERROR_MESSAGE%</err> 
where under 
Tag <Statistics > 

YearMonth = month of a year 
AvgDataSize = average size in data area 
AvgDataRawSize = average size in data area (in bytes) (added since v5.2.5.0) 
AvgDataNo = average number of files in data area 
AvgRetainSize = average size in retention area 
AvgRetainRawSize = average size in retention area (in bytes) (added since v5.2.5.0) 
AvgRetainNo = average number of files in retention area 
AvgUploadSize = average uploaded size 
AvgUploadRawSize = average uploaded size (in bytes) (added since v5.2.5.0) 
AvgUploadNo = average number of uploaded files 
AvgTotalStorageSize = average size in storage 
AvgTotalStorageRawSize = average size in storage (in bytes) (added since v5.2.5.0) 
AvgTotalStorageNo = average number of files in storage 

Tag <Storage> 
Date = the date of the statistics calculated 
DataSize = total data size uploaded 
DataRawSize = total data size uploaded (in bytes) (added since v5.2.5.0) 
DataNo = total data number 
RetainSize = total size in retention area 
RetainRawSize = total size in retention area (in bytes) (added since v5.2.5.0) 
RetainNo = total number in retention area 
UploadSize = total uploaded size 
UploadRawSize = total uploaded size (in bytes) (added since v5.2.5.0) 
UploadNo = total uploaded number 
TotalStorageSize = total size of storage 
TotalStorageRawSize = total size of storage (in bytes) (added since v5.2.5.0) 
TotalStorageNo = total storage number 

Example: 
http://BACKUP_SERVER/obs/api/GetUser StorageStat.do?SysUser=system&SysPwd=system&LoginName=john&YearMonth=2005-07

18.20 Listing User Storage  
The following table describes all information required to invoke the [List Users Storage] API to get a list of 
storage information for all users available within OBS. 

URL: 
http://BACKUP_SERVER/obs/api/ListUsersStorage.do

Parameters: 
Key Value Descriptions 

SysUser String OBS’s System Username 

SysPwd String OBS’s System password 

Return Value: 
If successful, returns 
 
<users> 
<user LoginName="john" Alias=”” UserType=”” Quota=””  

EnableMSSQL="Y" EnableMSExchange="Y" 
EnableOracle="Y" EnableLotusNotes="Y" 
EnableLotusDomino="Y" EnableMySQL="Y" 
EnableInFileDelta="Y" EnableShadowCopy="Y" 

http://backup_server/obs/api/ListUsersStorage.do
http://backup_server/obs/api/GetUser%20StorageStat.do?SysUser=system&SysPwd=system&LoginName=john&YearMonth=2005-07
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EnableExchangeMailbox=Y ExchangeMailboxQuota=10 
DataSize="1234” DataFile="1234" 
RetainSize="1234" RetainFile="1234" 
Status=”SUSPENDED” 
ClientType="OBM" Language="en"  > 

<Contact name="John (Email1)" email="john@yourcompany.com" /> 
<Contact name="John (Email2)" email=" johnmy@yourcompany.com " /> 
</user> 
…
…
</users> 
 

If there is an error, returns <err>%ERROR_MESSAGE%</err> 
Where 

LoginName = login name 
Alias = user’s alias 
UserType = user type [ PAID | TRIAL ] 
Quota = quota in bytes 
Language = user’s language 
EnableMSSQL = MS SQL enabled [ Y | N ] 
EnableMSExchange = MS Exchange enabled [ Y | N ] 
EnableOracle = Oracle enabled [ Y | N ] 
EnableLotusNotes = Lotus Notes enabled [ Y | N ] 
EnableLotusDomino = Lotus Domino enabled [ Y | N ] 
EnableMySQL = MySQL enabled [ Y | N ] 
EnableInFileDelta = In-file Delta enabled [ Y | N ] 
EnableShadowCopy = Shadow Copy enabled [ Y | N ] 
EnableExchangeMailbox = MS Exchange Mailbox enabled [ Y | N ] 
ExchangeMailboxQuota = MS Exchange Mailbox quota 
DataFile = total number of files in the data area 
DataSize = total amount of bytes in the data area 
RetainFile = total number of files in the retention area 
RetainSize = total amount of bytes in the retention area 
Status = status of user account [ENABLE | SUSPENDED] (added since v.5.2.2.5) 
ClientType = client type [ OBM | ACB ] 

Example: 
http://BACKUP_SERVER/obs/api/ListUsersStorage.do?SysUser=system&SysPwd=system

18.21 Get License 
The following table describes all information required to invoke the [List License] API to get version of OBS, used 
and unused licenses available within OBS. (added since v5.2.5.0) 

URL: 
http://BACKUP_SERVER/obs/api/GetLicense.do

Parameters: 
Key Value Descriptions 

SysUser String OBS’s System Username 

SysPwd String OBS’s System password 

Return Value: 
If successful, returns 
<License ProductName="Offsite Backup Suite, OEM Edition" ObsVersion="5.2.4.3" ExpiryDate="Unlimited" 
SupportExpiryDate="2008/10/31" MaxQuota="Unlimited"><OBM Quota="500" Available="498" Used="2"/><ACB Quota="500" 
Available="500" Used="0" AcbUsedObmUsers="0"/><MSExchange Quota="500" Available="499" Used="1"/><MSExchangeMail 
Quota="500" Available="500" Used="0"/><MSSQL Quota="300" Available="299" Used="1"/><Oracle Quota="500" Available="499" 
Used="1"/><MySQL Quota="Unlimited" Available="Unlimited"/><LotusDomino Quota="500" Available="499" Used="1"/><LotusNotes 
Quota="300" Available="299" Used="1"/><InFileDelta Quota="500" Available="499" Used="1"/><VolumeShadowCopy Quota="500" 
Available="499" Used="1"/></License> 
 
If there is an error, returns <err>%ERROR_MESSAGE%</err> 
Where 

ProductName = product name of OBS 
ObsVersion = version of OBS 
ExpiryDate = expiry date of OBS 
SupportExpiryDate = support expiry date of OBS 
MaxQuota = maximum quota of OBS 
Quota = quota 
Available = unused quota 
Used = used quota 
AcbUsedObmUsers = number of ACB users which used the quota of OBM users 
OBM = OBM users 
ACB = ACB users 
MSExchange = MS Exchange Brick level module 
MSExchangeMail = MS Exchange Mail level module 

http://backup_server/obs/api/GetLicense.do
http://backup_server/obs/api/ListUsersStorage.do?SysUser=system&SysPwd=system
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MSSQL = MSSQL module 
OracleUsers = Oracle module 
MySQL = MySQL module 
LotusDomino = Lotus Domino module 
LotusNotes = Lotus Notes module 
InFileDelta = In-file delta module 
VolumeShadowCopy = Volume shadow copy module 

Example: 
http://BACKUP_SERVER/obs/api/GetLicense.do?SysUser=system&SysPwd=system

18.22 Get Replication Mode 
The following table describes all information required to invoke the [List Replication Mode] API to get the mode of 
replication available within OBS. (added since v5.2.5.0) 

URL: 
http://BACKUP_SERVER/obs/api/GetReplicationMode.do

Parameters: 
Key Value Descriptions 

SysUser String OBS’s System Username 

SysPwd String OBS’s System password 

Return Value: 
If successful, returns 
<Replication Mode="DISABLED"/> 
Or 
<Replication Mode="UNSYNC" File="D:\Test-Data\obs52\user\kwong\files\1194504073875\Current\0x5f\0x3d\0xd2\0xc3\1103301195"/>
Or 
<Replication Mode="SYNC" File="D:\Test-Data\obs52\user\kwong\files\1194504073875\Current\0x5f\0x3d\0xd2\0xc3\1103301195"/> 
Or 
<Replication Mode="LOGGING" File="D:\Test-Data\obs52\system\logfiles\log0001.alf"/> 
 
If there is an error, returns <err>%ERROR_MESSAGE%</err> 
Where 

Mode = mode of replication as follow: 
1. DISABLED = disabled replication 
2. LOGGING = logging mode 
3. UNSYNC = un-synchronization mode 
4. SYNC = synchronization mode 

File = current replicating file 

Example: 
http://BACKUP_SERVER/obs/api/GetReplicationMode.do?SysUser=system&SysPwd=system

18.23 Send Forgot Password Email 
The following table describes all information required to invoke the [Send Forgot Password Email] API to invoke 
the sending forgot password email operation in OBS. (added since v5.2.5.0) 

URL: 
http://BACKUP_SERVER/obs/api/SendForgotPasswordEmail.do

Parameters: 
Key Value Descriptions 

SysUser String OBS’s System Username 

SysPwd String OBS’s System password 

LoginName String Login name of the user 

Return Value: 
If successful, returns <Reply><Success/></Reply> 
If there is an error, returns <err>%ERROR_MESSAGE%</err> 

Example: 
http://BACKUP_SERVER/obs/api/SendForgotPasswordEmail.do?SysUser=system&SysPwd=system&LoginName=test

18.24 Additional APIs 
If you need additional APIs to automate your business workflow, please feel free to let us know.  

http://backup_server/obs/api/SendForgotPasswordEmail.do?SysUser=system&SysPwd=system&LoginName=test
http://backup_server/obs/api/SendForgotPasswordEmail.do
http://backup_server/obs/api/GetReplicationMode.do?SysUser=system&SysPwd=system
http://backup_server/obs/api/GetReplicationMode.do
http://backup_server/obs/api/GetLicense.do?SysUser=system&SysPwd=system
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19 Frequently Asked Questions 
The chapter contains a list of frequently asked questions  

19.1 How to backup OBS? 
The best method to backup an OBS is using the replication module. It performs a near real time replication of 
OBS and it is not necessary to shutdown the backup services when backing up OBS.  

If you want to backup the complete OBS to tape, simply backup the following directories: 

i. The program directory (default directory is shown below) 

a. Windows – “C:\Program Files\Ahsay Offsite Backup Server” 

b. Linux – “/usr/local/obs” 

c. Mac OS X – “/Applications/OBS” and “/System/Library/StartupItems” or 
“/Library/StartupItems” (for Tiger or later)  

This directory contains relatively static data. You can backup this directory easily using any CD/DVD 
burning software available in the market. 

ii. The [System Home] directory in OBS (this can be found in the [Manage System] -> [System Home] 
entry after you have logged onto the administrative interface of OBS) 

iii. All [User Homes] directories in OBS (this can be found in the [Manage System] -> [User Homes] 
entries after you have logged onto the administrative interface of OBS) 

Both [System Home] and [User Homes] directories contains dynamic data. To ensure that you have a consistent 
image of all files within this directory, please shutdown the backup service (or at least make sure backup 
activities are not very active) when backing them up. 

19.2 How can I rebuild an OBS server from scratch? 
To rebuild an OBS from backup, please do this: 

i. Restore the program directory (the default location is shown below) 

d. Windows – “C:\Program Files\Ahsay Offsite Backup Server” 

e. Linux – “/usr/local/obs” 

f. Mac OS X – “/Applications/OBS” and “/System/Library/StartupItems” or 
“/Library/StartupItems” (for Tiger or later) 

ii. Restore the [System Home] directory (back to its original directory if possible) 

iii. Restore all [User Homes] directories (back to their original directories if possible) 

iv. If you have restored the [System Home] directory or any of the [User Homes] directories to 
another directory (instead of the original directory), please open 

g. Windows – “C:\Program Files\Ahsay Offsite Backup Server\conf\obs.xml” 

h. Linux – “/usr/local/obs/config/obs.xml” 

i. Mac OS X – “/Applications/OBS/config/obs.xml”  

and modify the <system-home> and/or <user-home> parameters within the [obs.xml] file to 
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reflect the correct paths for these directories. 

v. (for Windows) Run [C:\Program Files\Ahsay Offsite Backup Server\bin\Install-Service.bat] to install 
OBS as Windows services. 

vi. Startup the backup services 

19.3 How can I relocate users between different user homes? 
Assuming you want to relocate a user from an old drive to a new drive (e.g. from D:\User to E:\User) 

i. Logon to the backup server [Administration Console] 

ii. Under the [Manage System] page, enter another [User Home] (in this case, E:\User) in the [New] 
textbox provided and press the [Update] button 

iii. Shutdown the backup service from [Control Panel] -> [Administrative Tools] -> [Services] -> 
[Ahsay Offsite Backup Server] 

iv. Move the user directory to the new user home (e.g. D:\user\xxxx -> E:\User\xxxx) 

v. Startup the backup service from [Control Panel] -> [Administrative Tools] -> [Services] -> [Ahsay 
Offsite Backup Server] 

19.4 How do I add new storage to an existing server? 
Assuming you want to want a user to a new drive (e.g. from C:\Program Files\Ahsay Offsite Backup Server\user 
to E:\User) 

i. Logon to the backup server [Administration Console] 

ii. Under the [Manage System] page, enter another [User Home] (in this case, E:\User) in the [New] 
textbox provided and press the [Update] button 

iii. Shutdown the backup service from [Control Panel] -> [Administrative Tools] -> [Services] -> [OBS] 

iv. Move the user directory to the new user home (e.g. C:\Program Files\Ahsay Offsite Backup 
Server\user\xxxx -> E:\User\xxxx 

v. 5. Startup the backup service from [Control Panel] -> [Administrative Tools] -> [Services] -> [OBS] 

19.5 How can I tell which OBM version is being used to run a 
backup job? 

Starting from OBM 5.0.1.5, you can tell which OBM version is being used to run a backup job by inspecting the 
backup report of a backup job from the [OBS Web User Console] -> [Report] -> [Detailed Report] page. 
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19.6 How to run OBS under non-root user under Linux/Unix? 
OBS contains a set of APIs (Application Programming Interface),  

i. Shutdown OBS by running $OBS_HOME/bin/startup.sh 

ii. Setup port forwarding using iptables 
 
(For Linux Kernel 2.4 or above) 
[root@backup] # iptables -t nat -A PREROUTING -p tcp --dport 80 -j REDIRECT --to-port 9080 
[root@backup] # iptables -t nat -A PREROUTING -p tcp --dport 443 -j REDIRECT --to-port 9443 
or 
[root@backup] # iptables -t nat -A PREROUTING -p tcp –d x.x.x.x --dport 80 -j REDIRECT --to-
port 9080 
[root@backup] # iptables -t nat -A PREROUTING -p tcp –d x.x.x.x --dport 443 -j REDIRECT --to-
port 9443 

(For Linux Kernel 2.2) 
[root@backup] # ipchains -I input --proto TCP --dport 80 -j REDIRECT 9080 
[root@backup] # ipchains -I input --proto TCP --dport 443 -j REDIRECT 9443 
or 
[root@backup] # ipchains -I input --proto TCP –d x.x.x.x --dport 80 -j REDIRECT 9080 
[root@backup] # ipchains -I input --proto TCP –d x.x.x.x --dport 443 -j REDIRECT 9443 

You need to use the -d option if you have modified %INSTALL_HOME%\conf\server.xml to listen to 
only a single IP address (e.g. x.x.x.x) 

iii. Save this setting by running (so you don’t need to type this in again when you reboot your machine) 
 
(For Linux Kernel 2.4 or above) 
[root@backup] # service iptables save 
or 
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(For Linux Kernel 2.2) 
[root@backup] # service ipchains save 

iv. Setup forward for local TCP requests from local machine  

a. Create two files, named http and https, under the /etc/xinetd.d directory 

Content of /etc/xinetd.d/http 
# Redirects any requests on port 80 to port 9080  
# (where OBS is listening for HTTP traffic) 
 
service http 
{

socket_type = stream 
 protocol = tcp 
 user  = root 
 wait  = no 
 port  = 80 
 redirect = localhost 9080 
 disable = no 
}

Content of /etc/xinetd.d/https 
# Redirects any requests on port 443 to port 9443 
# (where OBS is listening for HTTPS traffic) 
 
service https 
{

socket_type = stream 
 protocol = tcp 
 user  = root 
 wait  = no 
 port  = 443 
 redirect = localhost 9443 
 disable = no 
}

b. Restart the xinetd service by 
 
[root@backup] # service xinetd restart 

v. Configure OBS to listen on port 9080 and 9443 for HTTP and HTTPS traffic. Please refer to the 
section on Listening to non-standard TCP/IP port for more information. 

vi. Create a non-root user and group (both named obs) to run OBS service 
 
[root@backup] # groupadd obsgrp 
[root@backup] # useradd obs –g obsgrp 

Note: you need to ensure that “obs” has privilege to execute the “ifconfig” command. 
 

vii. Shutdown the OBS backup service  

(Unix / Linux) [root@backup]# /etc/init.d/obs stop 
(FreeBSD) [root@backup]# /usr/local/etc/init.d/obs stop 

viii. Open the OBS startup script file [ /etc/rc.d/init.d ] and change the OBS_USER environment variable 
line to a Linux/Unix user (e.g. obs) 
 

export OBS_USER=obs 

ix. Change the owner and group of the $OBS_HOME directory and all subdirectories to “obs” and 
“obsgrp” respectively  
 
[root@backup] # chown –R obs:obsgrp $OBS_HOME 
 
If the [USER_HOMES] and [SYSTEM_HOME] directories defined under the [Manage System] page 
on the web interface are not located inside the $OBS_HOME directory, you need to change the 
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ownership of these directories to “obs:obsgrp” as well. For example: 
 
[root@backup] # chown –R obs:obsgrp [USER_HOME 1] 
[root@backup] # chown –R obs:obsgrp [USER_HOME 2]  
[root@backup] # chown –R obs:obsgrp [SYSTEM_HOME] 

x. Startup the OBS backup service  

(Unix / Linux) [root@backup]# /etc/init.d/obs start 
(FreeBSD) [root@backup]# /usr/local/etc/init.d/obs start 

xi. You can now use “netstat -a” to verify that OBS is listening on port 9080 and port 9443. Also, you 
can use “ps aux” to verify that OBS is started under the user “obs”. 
 

Sample output of verification commands above 
[root@backup] # netstat -a 
Active Internet connections (servers and established) 
Proto Recv-Q Send-Q Local Address           Foreign Address           State 
tcp        0      0 *:http                      *:*                         LISTEN 
tcp        0      0 *:https                     *:*                         LISTEN 
tcp        0      0 *:9080 *:*                         LISTEN 
tcp        0      0 *:9443 *:*                         LISTEN 
…
[root@backup] # ps aux 
…
obs 894  0.3 11.1 778064 57136 ?      S    12:30   1:06 
/usr/local/obs/java/bi 
…

19.7 How do I start up RPS as OBS? 
Assumptions: 

i. You want to kick off RPS as OBS 

ii. The [Home Directory] of the receiver of OBS configured on RPS is [D:\RepHome] 

iii. The [User Homes] of OBS are [E:\Users] and [F:\Users] on OBS 

iv. The [System Home] of OBS is [E:\System] on OBS 

Please do this on RPS: 

i. Copy “D:\RepHome\files\C%3A\Program Files\Ahsay Offsite Backup Server” to “C:\Program 
Files\Ahsay Offsite Backup Server” 

ii. Copy “D:\RepHome\files\E%3A\Users” to “E:\Users”, “D:\RepHome\files\F%3A\Users” to 
“F:\Users” and “D:\RepHome\files\E%3A\System” to “E:\System” 
 
If the partitions for E:\ or F:\ are not available, just copy these directories to any locations you 
want but please make sure to open “C:\Program Files\Ahsay Offsite Backup Server\conf\obs.xml” 
and modify the entries for [user-home] and [system-home] with the correct paths) 

iii. Run “C:\Program Files\Ahsay Offsite Backup Server\bin\install-service.bat” to install OBS as 
windows services 

iv. Shutdown the [Control Panel] -> [Administrative Tools] -> [Services] -> [Ahsay Replication Server] 
service 

v. Startup the [Control Panel] -> [Administrative Tools] -> [Services] -> [Ahsay Offsite Backup 
Server] service 

Please take a look at “C:\Program Files\Ahsay Offsite Backup Server\logs\obs*.log” and “C:\Program Files\Ahsay 
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Offsite Backup Server\logs\cat*.log” if you run into any problems. 

19.8 How do I move OBS to a new IP address? 
If you want to move your OBS installation to a new IP address, please do this: 

i. Update your DNS record of the hostname of your OBS to point to a new IP address (Please note 
that it could take up to 24 hours for this changes to propagate to all DNS servers around the world) 

ii. Move your existing OBS installation to another IP address and restart the backup services of OBS 
once you are on a new IP address 

iii. All existing clients installation should pick up this change and send their backup data automatically 
to OBS located on the new IP address 

iv. If any existing client installation doesn’t run its scheduled backup, please ask the user to restart the 
[Online Backup Scheduler] service under [Services] 

19.9 How do I move OBS to a new server? 
To move an existing OBS installation to a new server, please do this: 

i. Copy the program directory (the default location is shown below) from your old server to your new 
server 

Windows – “C:\Program Files\Ahsay Offsite Backup Server” 

c. Linux – “/usr/local/obs” 

d. Mac OS X – “/Applications/OBS” and “/System/Library/StartupItems” or 
“/Library/StartupItems” (for Tiger or later) 

ii. Copy the [System Home] directory to the new server (back to its original directory if possible). The 
default location is “C:\Program Files\Ahsay Offsite Backup Server\system”. If you didn’t change the 
setting of this directory, it should have been copied over to the new server already in step (i). 

iii. Copy the [User Homes] directories to the new server (back to its original directory if possible). The 
default location is “C:\Program Files\Ahsay Offsite Backup Server\user”. If you didn’t change the 
setting of these directories, they should have been copied over to the new server already in step (i). 

iv. If you have restored the [System Home] directory or any of the [User Homes] directories to 
another directory (instead of the original directory), please open 

a. Windows – “C:\Program Files\Ahsay Offsite Backup Server\conf\obs.xml” 

b. Linux – “/usr/local/obs/config/obs.xml” 

c. Mac OS X – “/Applications/OBS/config/obs.xml”  

and modify the <system-home> and/or <user-home> parameters within the [obs.xml] file to 
reflect the correct paths for these directories. 

v. (for Windows) Run [C:\Program Files\Ahsay Offsite Backup Server\bin\Install-Service.bat] to install 
OBS as Windows services. 

vi. Startup the backup services 

Note that after moving OBS to the new server, you will need to activate your existing license key on the new OBS 
machine. When doing so, you would get the following error message at the top of the [Software License] page: 

Internal Error no. 1011 
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This is because one license key can only be used to activate one machine at the same time. However, there is a 
7-day grace period. Your new server should remain functional for 7 days after the activation. To resolve this error, 
you need to: 

i. Switch off the old OBS server 

ii. Submit a ticket to Technical Support, quoting “Internal Error no. 1011” and provide your licensee 
name and license key 

iii. We will then reset your license key on our side 

iv. You can then activate your new OBS server again and the error will be gone  

19.10 How do I set the user home directory to a network drive? 
If you want to set the [User Home] directory to a network drive, please use UNC path instead of drive letter as 
your [Manage System] -> [User Homes] entry, i.e. use \\SERVER\SHARE instead of H:\.  

If user authentication is required to access the network drive, please use [Control Panel] -> [Administrative Tools] 
-> [Services] -> [Ahsay Offsite Backup Server] -> [Log on] -> [This Account] to setup an username/password 
gain to access the network path. Also, please make sure the Windows account you have entered into the [This 
Account] section has administrative privileges on the backup server itself. 

19.11 Can I perform an integrity check on all backup files stored 
under OBS? 

If you are interested in forcing an integrity check on all backup files stored under OBS, please do this:  

i. Browse to [OBS Web Administrator’s Console] -> [Manage System] -> [Routine Job] -> [Rebuild 
User Storage] 

ii. Check the [Enable Backup File Validation] option 

iii. Uncheck the [Skip Validated Files] option 

iv. Select the [Move to retention dir] option 

v. Schedule the [Rebuild User Storage] job to a time in the near future 

vi. Check the [Manage Log] -> [System Log] page to see if OBS files any corrupted files 

Please refer to the Rebuild User Storage section for more information. 
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20 Troubleshooting 
The chapter contains solutions to all common error messages that can be found in OBS. 

20.1 I am getting the message “Error getting report from all IP 
addresses” in my email. What can I do to correct this? 

Please check if any of your disk partitions is full. Pay special attention to the OBS log directory: 

� (Windows) C:\Program Files\Ahsay Offsite Backup Server\logs 

� (Linux) /usr/local/obs/logs 

� (Mac OS X) /Applications/OBS/logs 

It is safe to delete any log files here from the system. 

Also, are you using non-default TCP port for the backup server? If so, please append the port number of your 
HTTP (NOT HTTPS) connector to the [Manage System] -> [Host Name] entry. 

E.g. backup.yourcompany.com:8080 

If you are not using custom port, open a browser on the backup server and type in the value of [Manage System] 
-> [Host Name] as an URL. Check if you get the backup server homepage. If you don't get the webpage, try until 
you can reach it and put this value in the [Manage System] -> [Host Name] field. (Please omit the page name, 
i.e. /index.jsp, from this entry)  

If you are running OBS on Linux Kernel 2.6, you could have run into the compatibility problem of running Java 
program on Linux Kernel 2.6 (see this 
http://www.jroller.com/page/dissonance/20050630#fedora_core_4_and_jdk). Please try this to fix this problem: 

i. Open [$OBS_HOME/bin/startup.sh] 

ii. Change the line 
 
export CATALINA_OPTS="-Xms64m -Xmx512m -client -Dsun.net.inetaddr.ttl=10800 -
Dnetworkaddress.cache.ttl=10800 -Dsun.net.inetaddr.negative.ttl=0 -
Dnetworkaddress.cache.negative.ttl=0" 
 
to 
 
export CATALINA_OPTS="-Xms64m -Xmx512m -client -Dsun.net.inetaddr.ttl=10800 -
Dnetworkaddress.cache.ttl=10800 -Dsun.net.inetaddr.negative.ttl=0 -
Dnetworkaddress.cache.negative.ttl=0 -Djava.net.preferIPv4Stack=true" 

iii. Restart the backup service by running [service obs stop] and then [service obs start] 

20.2 Some of my backup accounts have disappeared. What can I do 
to recover them? 

i. Go to the log directory (C:\Program Files\Ahsay Offsite Backup Server\logs) 

ii. Take a look at the latest obs*.log file 

iii. Scroll to the bottom and check if you can find a "Profile Corrupted" error message 

iv. If there is one, open File Explorer and go to the [User Home] / [Login Name] / db directory for this 
user 

v. Check if Profile.xml is missing (or corrupted, just open to take a look) 

vi. If it is missing, just use the backup copy (e.g. Profile.xml.1) to recreate a new one 
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vii. It is not missing, check if this file is corrupted (Make sure the XML document is complete). If it is 
corrupted, just use the backup copy (e.g. Profile.xml to recreate a new one) 

viii. This account should now appear on the backup server. 

ix. If you are still no seeing all your users, just go back to step 2 and check if there is another 
corrupted profile. 

20.3 OBS running on Linux crashes unexpectedly and randomly 
when Samba is being used to access user home stored on 
another server? 

Please use CIFS that supports large file sizes over SMB. 
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21 Appendixes 

21.1 Contact Us 
If you need any additional information, please submit your question to us using our Helpdesk Ticketing System.

http://kb.ahsay.com/index.php?_m=tickets&_a=submit
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